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1. WSTĘP

Gratulujemy! Zakupiłeś kompletny system treningowy, który pomoże ci w realizacji własnych potrzeb
treningowych. Instrukcja zawiera pełny opis funkcji twojego Polara RS800CX.
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2. CZĘŚCI SKŁADOWE ODBIORNIKA

1. Polar RS800CX wyświetla podczas treningu tętno; jest ono, wraz z pozostałymi danymi, zapisywane.

2. Nadajnik Polar WearLink® W.I.N.D : wysyła sygnał rytmu serca do odbiornika. Składa się z nadajnika i
elektrod.

CD-ROM: CD zawiera oprogramowanie Polar ProTrainer 5 TM oraz pełną instrukcję.

Akcesoria (Opcjonalnie)

1. Polar s3 stride sensorTM W.I.N.D.: przesyła dane dotyczące biegu (prędkość/tempo oraz dystans) do
odbiornika. Mierzy również kadencję i średnią długość kroku .

2. Polar G3 GPS sensorTM W.I.N.D.: do użytku w treningu outdoorowym; pokazuje prędkość, dystans oraz
drogę wykorzystując do tego technologię Global Position System (GPS). Dane o swojej trasie możesz
przesłać do programu Polar ProTrainer 5 (aby wyświetlić je w Google Earth albo przekonwertować na
pliki GPX). Aby uzyskać więcej informacji, przeczytaj pomoc oprogramowania.

3. Polar Cycling Speed SensorTM W.I.N.D.: dokonuje pomiaru prędkości i dystansu podczas jazdy na
rowerze.

4. Polar Cadence Sensor TM W.I.N.D.: pomiar kadencji (ilość obrotów korby na minutę) podczas jazdy na
rowerze .

Podczas używania Polar G3 GPS sensor z Polar s3 stride sensor lub Polar cycling speed sensor, GPS będzie
używany tylko do wyznaczania trasy. Jednak, jeżeli s3 stride sensor lub cycling speed sensor będą poza
zasięgiem (np. typ treningu zmienił się podczas ćwiczenia), odbiornik będzie automatycznie wskazywać
prędkość i dystans z sensora GPS. W ten sposób prędkość i dystans są zabezpieczone podczas sesji
treningowej. Aby ponownie rozpocząć używanie s3 stride sensor lub the cycling speed sensor, przytrzymaj
przycisk LIGHT i wybierz Seek sensor.

POLSKI

6 CZĘŚCI SKŁADOWE ODBIORNIKA



3. ROZPOCZĘCIE

Podstawowe ustawienia

Przed rozpoczęciem treningu należy wprowadzić dane podstawowe. Celem uzyskania optymalnych
wyników pomiarów, wprowadź dokładne dane.

Aby przeglądać dane, używaj przycisków UP, DOWN ; potwierdzaj OK. Wartości będą zmieniać się
szybciej jeżeli przytrzymasz przycisk UP lub DOWN.

1. Aby aktywować odbiornik, wciśnij dwa razy OK.
2. Pojawi się logo Polar. Wciśnij OK.
3. Language: wybierz English, Deutsch, Español, Français lub Italian.
4. Start with basic settings zostanie wyświetlone. Wciśnij OK.
5. Time: wybierz 12h lub 24h. Przy 12h, wybierz AM lub PM. Ustawienie czasu lokalnego.
6. Date: ustawienie aktualnej daty, dd=dzień, mm=miesiąc, yy=rok.
7. Units: Wybierz jednostki metryczne (kg/cm/km) lub brytyjskie (lb/ft/mi).
8. Weight: Wprowadź swoją wagę. Aby zmienić jednostki, przytrzymaj LIGHT.
9. Height: Wprowadź swój wzrost. Jeżeli używasz brytyjskich jednostek, najpierw podaj stopy (ft), później

cale (in).
10. Birthday: wprowadź datę swoich urodzin, dd=dzień, mm=miesiąc, yy=rok.
11. Sex: zaznacz płeć Male lub Female.
12. Settings OK? zostanie wyświetlone. Wybierz Yes: ustawienia zostały zaakceptowane i zapisane.

Odbiornik zacznie wskazywać godzinę. Wybierz No jeżeli ustawienia są błędne i wymagają zmiany. Aby
powrócić do danych, ktore chcesz zmienić, wciśnij STOP .
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Struktura Menu
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4. PRZYGOTOWANIE DO TRENINGU

Planowanie treningu

Rodzaje ćwiczeń
Możesz wykorzystać gotowe ćwiczenia lub, przy pomocy odbiornika, stworzyć własne. Tworząc własne
ćwiczenia, za pomocą oprogramowania Polar ProTrainer 5, przeniesiesz je do swojego odbiornika.

Wybierz Settings > Exercise

Menu Exercise zawiera listę ćwiczeń. Poruszaj się pomiędzy opcjami przy użyciu przycisków UP oraz
DOWN; wejdź w ćwiczenie przyciskając OK.

• Free: Wolne ćwiczenie bez bieżących ustawień.
• Basic: Podstawowy trening ze średnią intensywnością. Czas trwania około 45 min.
• Interval : Podstawowy trening interwałowy. Ćwiczenie zaczyna się od 15-sto minutowej rozgrzewki, na

którą składa się 1km interwału i 3-minutowa przerwa (5 powtórzeń). Sesja kończy się 15-sto minutowym
odpoczynkiem.

• OwnZone: Odbiornik automatycznie określi strefy dla rytmu serca oraz wydolności układu krążenia.
Nazywa się to OwnZone. Sugerowany czas treningu to 45 minut. Celem dalszych informacji, przejdź do
Wyznaczenie OwnZone (strona 22). Dodatkowe informacje znajdziesz w Trening OwnZone (strona 54).

• Add new: Stwórz i zapisz własne ćwiczenie podstawowe. W swoim odbiorniku możesz przechowywać
maksymalnie 10 ćwiczeń + 1 ćwiczenie Free .

Po wyborze ćwiczenia wyświetlone zostaną następujące opcje. Wybierz szukaną opcję i wciśnij OK.

1. Select ćwiczenie ustawione jako domyślne. Podczas twojego kolejnego treningu, Polar zaproponuje to
ćwiczenie jako domyślne.

2. View Ustawienia ćwiczeń. Przewiń UP lub DOWN aby przeglądać:

a. Ćwiczenie podstawowe w każdej (1-3) ze stref: rytm serca, prędkość/tempo lub kadencję dla każdej
strefy, stoper/dystans* dla strefy, lub

b. Ćwiczenie stworzone przy pomocy oprogramowania: nazwa, opis, czas ćwiczenia. (Wciśnij i
przytrzymaj LIGHT aby zobaczyć etap ćwiczenia oraz wybrany profil sportowy)

3. Edit Basic lub OwnZone ćwiczenia odpowiadające indywidualnym predyspozycjom. Stworzone przez
siebie ćwiczenie możesz, przy pomocy odbiornika, modyfikować. Celem dalszych informacji, przejdź do
Tworzenie nowych ćwiczeń (strona 9). Jeżeli stworzyłeś ćwiczenie z oprogramowaniem, które zawiera
fazy, nie możesz ich edytować za pomocą odbiornika.

4. Rename Basic, Interval lub inne ćwiczenia, stworzone za pomocą odbiornika.

5. Default - powrót do ustawień domyślnych ćwiczeń Basic, Interval lub OwnZone.

6. Delete usuwanie ćwiczeń za pomocą odbiornika lub oprogramowania.

Tworzenie nowych ćwiczeń
Stwórz nowe ćwiczenie ze strefami

Stwórz własne ćwiczenie za pomocą odbiornika. Przy pomocy programu Polar ProTrainer 5 można
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tworzyć bardziej zaawansowane ćwiczenia. Więcej informacji w pomocy programu.

Wybierz Settings > Exercises > Add new

1. Ustaw Number of zones dla ćwiczenia (0-3) i wciśnij OK. Dla 0 stref, zobacz Stwórz nowe ćwiczenie ze
strefami.

2. Wybierz Zone type:

• T#tno

Wybierz, dla stref tętna, sport zones lub manual (strefę wyznaczaną ręcznie). Wciśnij OK.
Sport zone: wybierz jedną ze stref (np. Z1: 50-59%) dla swojego ćwiczenia. Wciśnij OK aby przejść
do kroku 3.
Polar sport zones są strefami intensywności, wyrażonymi w procentach tętna maksymalnego. Pięć
różnych stref jest ustawionych w odbiorniku jako domyślne: Bardzo niska (50-59% HR max), niska
(60-69% HRmax), przeciętna (70-79% HRmax), wysoka (80-89% HRmax) oraz maksymalna (90-99%
HRmax). Domyślna wartość HRmax bazuje zazwyczaj na wieku, lecz: jeżeli znasz swoje progi tlenowe
i beztlenowe/znasz swoje przewidywane maksymalne tętno (HRmax-p) mierzone w Polar Fitness
TestTM/testowałeś maksymalne tętno sam lub laboratoryjnie - możesz samodzielnie zdefiniować
strefy wysiłkowe a tym samym lepiej dostosować je do swoich potrzeb treningowych. Aby uzyskać
więcej informacji, zapoznaj się z plikiem help w oprogramowaniu ProTrainer 5.

Manual (ustawienia r#czne): Ustaw górny oraz dolny limit strefy w bpm (uderzenia na minutę) lub
HR% / HRR%: wciśnij OK aby przejść do kroku 3.

• Speed/pace (pr#dko##/tempo) (wymagane są opcjonalnie: s3 stride sensor, G3 GPS sensor lub
cycling speed sensor W.I.N.D)
Dla stref prędkości/tempa; ustaw górny oraz dolny limit strefy. Wciśnij OK aby przejść do kroku 3.

• Cadence (kadencja) (wymagane są opcjonalnie: s3 stride sensor lub cadence sensor W.I.N.D.)
Dla stref kadencji; ustaw górny oraz dolny limit strefy. Wciśnij OK aby przejść do kroku 3.

3. Ustaw Zone guide (przewodnik po strefie) aby zmienić strefę po określonym czasie lub dystansie*.
Podczas treningu; odbiornik zaalarmuje cię gdy zmieni się strefa, w której aktualnie się znajdujesz.
• Timers : Ustaw czas dla strefy (minuty i sekundy) i wciśnij OK. Lub
• Distances (odleg#o#ci)*: Ustaw dystans dla strefy i wciśnij OK. Lub
• Off: Wybierz opcję wyłączenia dla timera lub dystansu i wciśnij OK.

Kiedy zdefiniujesz już pierwszą strefę, Zone 1 OK się wyświetli. Aby ustawić więcej niż jedną strefę,
powtórz krok 2 oraz 3 do momentu zdefiniowania wszystkich stref.

Kiedy ćwiczenie będzie gotowe, New exercise added zostanie wyświetlone. Nowe ćwiczenie (NewExe) jest
przechowywane w Exercises menu: możesz je wybrać podczas kolejnego treningu. Aby zmienić nazwę
ćwiczenia wybierz opcję Rename.

Stworzenie nowego ćwiczenia (bez stref)

Tworząc ćwiczenie bez stref, możesz użyć dystansu i timerów, które cię poprowadzą.

Wybierz Settings > Exercises > Add new

1. Number of zones : ustaw ilość stref na 0.
2. Guide type: Wybierz dźwięk stopera podczas ćwiczenia (przypomnienie np. o napiciu się) lub ustaw

dystans* (dla następujących czasów okrążeń, bez zapisywania ich).

Stoper
• Number of timers (liczba stoperów) : Wybierz liczbę pomiarów czasu (1-3) dla sesji. Wciśnij OK.
• Timer 1 : Zdefiniuj minuty i sekundy dla stopera i wciśnij OK. Lub

Dystansy*
• Number of distances : Wybierz liczbę pomiarów dystansów (1-3) dla sesji. Wciśnij OK.
• Distance 1: Wybierz dystans(y) i wciśnij OK.
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Powtarzaj krok 2 do momentu ustawienia wszystkich czasów lub dystansów*. Kiedy ćwiczenie będzie
gotowe, New exercise added zostanie wyświetlone. Nowe ćwiczenie (NewExe) jest przechowywane w
Exercises menu: możesz je wybrać podczas kolejnego treningu. Aby zmienić nazwę ćwiczenia wybierz
opcję Rename.

Kalibracja Polar s3 Stride Sensor W.I.N.D.
Dodatkowa kalibracja s3 sensora* zwiększa precyzję pomiaru prędkości, tempa oraz dystansu. Zaleca
się wykonanie kalibracji przed pierwszym użyciem jak również w przypadku jeśli zmieniłeś styl biegania
lub, jeżeli pozycja foot poda na bucie uległa dużej zmianie (np. jeżeli biegasz w nowych butach). Sensor
można skalibrować bądź poprzez przebiegnięcie trasy o znanej długości bądź poprzez ręczne
wprowadzenie wskaźnika.

Możesz skalibrować jeden s3 sensor dla jednego buta.

Kalibracja sensora poprzez bieg na określonym dystansie (kalibracja w biegu)
Sensor można skalibrować w dowolnej fazie ćwiczenia z międzyczasami; pod warunkiem, że nie jest to
ćwiczenie oparte na celach określonych odległością. Przebiegnij odcinek o znanej odległości (najlepiej
powyżej 1000 metrów).

Upewnij się, że opcja sensora w Polarze jest włączona (Settings > Features > Shoes/bikes > Shoes

03-01-02 > On).

Będąc na ekranie początkowym wciśnij raz OK. Wybierz Settings > Shoes/bikes > Shoes 03-01-02.

Następnie wybierz Start i zacznij biec.

Jeżeli jesteś w miejscu startowym odcinka, którego dystans znasz, wciśnij OK. Po przebiegnięciu całego
dystansu wciśnij OK. Dokonaj kalibracji sensora; alternatywnie:

1. Wciśnij i przytrzymaj LIGHT aby przejść do Settings. Lub

2. Wciśnij raz STOP. Wybierz Settings.

Wybierz Calibrate > Correct lap > Set true lap distance . Wyświetlany dystans zmień na ten, który
wlaśnie przebiegłeś i wciśnij OK.

Calibration complete (kalibracja zako#czona) parametr zostanie wyświetlony. Sensor został skalibrowany
i jest gotowy do użycia.

Ręczne wprowadzenie wskaźnika
Wskaźnik kalibracji jest obliczany jako proporcja rzeczywiście przebytej odległości do wskazań przed
kalibracją. Na przykład: przebiegłeś 1200m, ale odbiornik wskazuje dystans 1180m; wskaźnik kalibracji
wynosi 1,000. Oblicz nowy parametr kalibracji w następujący sposób: 1,000*1200/1180 = 1,017. Zakres
wskaźnika wynosi od 0,500 do 1,500.

Wskaźnik można skalibrować na cztery sposoby:

1. Przed ćwiczeniem.

Wybierz Settings > Features > Shoes/bikes > Shoe 03-01-02 > Calibrate .

Wybierz Calibration factor i wciśnij OK. Sensor został skalibrowany.

2. Po rozpoczęciu pomiaru tętna, lecz przed rozpoczęciem zapisu ćwiczenia.

Na oknie początkowym wybierz OK > Settings > Shoes/bikes > Shoes 03-01-02 > Calibrate .

Wybierz Calibration factor i wciśnij OK. Sensor został skalibrowany; możesz zacząć zapisywać
ćwiczenie przyciskając OK.
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3. Podczas ćwiczenia, poprzez zastopowanie zapisu.

Rozpocznij ćwiczenie poprzez dwukrotne naciśnięcie OK na oknie początkowym. Wciśnij raz STOP aby
zrobić pauzę w zapisie ćwiczenia.

Wybierz Settings > Calibrate > Set factor .

Wybierz Calibration factor i wciśnij OK. Sensor został skalibrowany. Kontynuuj zapis ćwiczenia poprzez
naciśnięcie OK.

4. Podczas ćwiczenia, bez zastopowania zapisu.

Rozpocznij ćwiczenie poprzez dwukrotne naciśnięcie OK na oknie początkowym. Wciśnij i przytrzymaj
LIGHT aby przejść do Settings.

Wybierz Calibrate > Set factor .

Wybierz Calibration factor i wciśnij OK. Sensor został skalibrowany. Kontunuuj bieg.

Pojawienie się komunikatu S sensor calibration failed oznacza, że sensor nie został skalibrowany; musisz
spróbować ponownie.

*opcjonalnie s3 stride sensor W.I.N.D. jest wymagany.
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5. TRENING

Zakładanie nadajnika
Załóż nadajnik celem pomiaru pulsu.

Przed rozpoczęciem zapisu treningu musisz założyć WearLink.

1. Zmocz dokładnie elektrody pod bieżącą wodą.

Aby zapewnić lepszy kontakt między skórą a nadajnikiem, zwłaszcza podczas długich ćwiczeń, zalecamy
używać żelu (ECG gel)

2. Przypnij nadajnik do elektrod . Wyreguluj długość elektrod tak, aby dokładnie przylegały do ciała.

3. Załóż i zapnij elektrody na wysokości klatki piersiowej, zaraz poniżej mięśni.

4. Upewnij się, że zmoczone elektrody dobrze przylegają do ciała, a logo Polara na nadajniku znajduje się
w pozycji centralnej.

Po zakończonym treningu zawsze odpinaj elektrody od nadajnika; zapobiegniesz w ten sposób
ich uszkodzeniu lub korozji. Dokładną instrukcję dotyczącą ich prania znajdziesz w Konserwacja i
przechowywanie (strona 61).

Nadajnik Polar WearLink może być używany ze specjalnym strojem sportowym, posiadającym wbudowane, z
delikatnego materiału, elektrody . Zwilż elektrody znajdujące się na stroju. Wepnij nadajnik prosto na strój bez
elektrod, tak aby logo Polar było w prostej pozycji .

Rozpoczęcie treningu

1. Załóż nadajnik, wg instrukcji, i rozpocznij pomiat tętna naciskając OK.

2. W ciągu 15 sekund na wyświetlaczu pojawi się twój puls.

• Jeżeli używasz sensora, wybierz shoe lub bike: przytrzymaj DOWN lub wejdź w Settings >
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Shoes/bikes. Liczba w dolnym prawym rogu wyświetlacza wskazuje wybór buta lub roweru. Stojąc
nieruchomo poczekaj aż odbiornik odbierze sygnał sensora; w zależności od rodzaju używanego
sensora (do biegania, jazdy na rowerze czy GPS) dany symbol przestanie mrugać.

• Aby szybko zmienić typ ćwiczenia, wciśnij i przytrzymaj UP.
3. Zacznij ćwiczenie od naciśnięcia OK.

Jeżeli wyświetli się następujący komunikat: (nazwa ćwiczenia) requires a speed sensor, twoje ćwiczenie
wymaga sensora prędkości aby wyświetlać prędkość/tempo i dystans* (np. masz zdefiniowane strefy dla
prędkości/tempa* dotyczące danego ćwiczenia). Odbiornik wróci do menu wyboru typu ćwiczenia; tam możesz
wybrać ćwiczenie, które nie wymaga sensora prędkości.

Ewentualnie, wybierz Settings, Reset trip lub Location.

W Settings możesz, przed rozpoczęciem treningu, zmienić lub przeglądnąć poszczególne ustawienia.
Celem dokładniejszych informacji na temat dostępności ustawień, przejdź do USTAWIENIA (strona 33).
Settings menu zawiera następujące opcje:
• Exercise : Wybierz typ ćwiczenia Free, Basic, Interval , lub OwnZone (w spisie znajdzie się także

ćwiczenie stworzone przez ciebie)

1. Select : ustaw ćwiczenie, które ma być wykonane domyślnie

2. View: Wgląd w ustawienia ćwiczenia.

• Shoes/bikes: Wybierz but 03-01-02, rower 03-01-02 lub nie dokonuj wyboru. W Settings > Features >

Shoes/bikes wyświetlone są wyłącznie buty/rowery przez ciebie aktywowane.

Jeśli wybierzesz opcję but lub rower, a równocześnie masz włączony GPS, ten ostatni będzie pokazywał
położenie oraz wyznaczał trasę.

• GPS: Ustaw funkcję GPS On/Off.

• Altitude: Włącz lub wyłącz wysokościomierz; dokonaj kalibracji.

• Rec.rate : Ustaw uśrednianie zapisu.

• RR data: Włącz lub wyłącz zapis RR.

• TZ Alarm: Włącz lub wyłącz dźwięk alarmu wyjścia poza strefę.

• HR view: wyświetlane tętno w uderzeniach na minutę (bpm) - dokonaj wyboru: jako % z tętna
maksymalnego (HR%) lub jako % rezerwy tętna (HRR%).

• Speed view: wyświetlana prędkość - dokonaj wyboru: prędkość* w kilometrach lub milach na godzinę
(km/h or mph) albo w minutach na kilometr lub milę (min/km or min/mi).

• A.Lap: Włącza/wyłącza opcję automatycznych okrążeń.

• Display: Modyfikacja wyświetlacza (celem uzyskania dalszych informacji, przejdź do Personalizacja
danych, wyświetlanych przez Odbiornik (strona 16)).

Reset trip Możliwość usunięcia dystansu przed rozpoczęciem sesji treningowej.

Location** możliwość sprawdzenia swojej aktualnej pozycji. Odbiornik określi twoją pozycję używając
ostatnich współrzędnych GPS. Szerokość i długość geograficzna są wyrażone w stopniach i minutach.
Liczba satelit jest widoczna w najniższym rzędzie.

Celem dalszej analizy trasy, przenieś dane do oprogramowania Polar ProTrainer 5. Aby uzyskać instrukcję,
przejdź do Software help .

*opcjonalny s3 stride sensor, G3 GPS sensor lub cycling speed sensor W.I.N.D jest wymagany.

**Opcjonalny G3 GPS sensor W.I.N.D. jest wymagany.
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Łączenie Ćwiczeń
RS800CX oferuje ci opcję łączenia kolejnych ćwiczeń. Jeśli, po zakończeniu sesji treningowej, nową
rozpoczniesz w przeciągu godziny Combine exercises? zostanie wyświetlone.

Aby dokonać połączenia, wybierz YES. W efekcie, podczas treningu, wyświetlone jest multisport
exercise. Połączonych może zostać maksymalnie dziesięć treningów. Aby uzyskać więcej informacji,
przejdź do Informacje na wyświetlaczu (strona 15).

Polar ProTrainer 5 umożliwi ci łączenie ćwiczeń (po treningu) wraz z ich dokładną analizą. Aby uzyskać więcej
informacji, przejdź do Polar ProTrainer 5 help.

Informacje na wyświetlaczu
Odbiornik umożliwia ci równoczesny wgląd w trzy różne linie informacji o ćwiczeniu. Naciskając UP lub
DOWN, możesz przeglądać różne ekrany. Nazwa ekranu pojawi się po kilku sekundach. Nazwa jest
wskazana w najniższym rzędzie informacji. Ilość wyświetlanych informacji zależy od, ustawionego na On,
zainstalowanego sensora oraz od rodzaju preferowanego ćwiczenia.

Ustawienie wyświetlacza odbiornika ułatwi ci Polar ProTrainer 5 software.

Domyślne ekrany podczas ćwiczenia:

Heart rate widok
Prędkość*/rytm*/Kalorie
Stoper
Tętno
*opcjonalny s3 stride sensor, G3 GPS sensor lub cycling speed sensor W.I.N.D jest
wymagany.

Stopwatch widok
Kalorie
Czas
Stoper
*opcjonalny s3 stride sensor, G3 GPS sensor lub cycling speed sensor W.I.N.D jest
wymagany.

Lap time widok
Wskaźnik strefy
Tętno
Czas okrążenia

Speed/pace widok
Kadencja*
Dystans**
Prędkość/Rytm**
* s3 stride sensor lub cadence sensor W.I.N.D. jest wymagany.
*opcjonalny s3 stride sensor, G3 GPS sensor lub cycling speed sensor W.I.N.D jest
wymagany.

Distance widok
Odliczanie czasu
Wskaźnik strefy
Dystans* / Czas okrążenia
*opcjonalny s3 stride sensor, G3 GPS sensor lub cycling speed sensor W.I.N.D jest
wymagany.
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Altitude widok
Tętno
Suma wzniesień
Wysokość

Multi-sport widok (wyświetlany tylko wówczas, jeżeli posiadasz połączone
aktualne ćwiczenia z poprzednimi plikami)
Całkowity czas trwania połączonych ćwiczeń
Całkowita ilość kalorii połączonych ćwiczeń
Całkowity dystans połączonych ćwiczeń*
*opcjonalny s3 stride sensor, G3 GPS sensor lub cycling speed sensor W.I.N.D jest
wymagany.

#wiczenie stworzone z Polar ProTrainer 5

Jeśli wykorzystujesz program treningowy z oprogramowania, detale swojej sesji
treningowej możesz oglądać oddzielnie. Celem uzyskania dalszych informacji,
przejdź do Wykonywanie Zaprogramowanych Ćwiczeń (strona 43).
Danych tych nie możesz modyfikować przy użyciu odbiornika.

Personalizacja danych, wyświetlanych przez Odbiornik
Przy pomocy odbiornika lub oprogramowania, dokonaj personalizacji wyświetlanych na ekranie Polara
danych, które chcesz widzieć podczas treningu . Pochodzące z oprogramowania ćwiczenia,,wraz z
widokiem, posiadają własne ekrany, które nie mogą być modyfikowane.

Na ekranie głównym wybierz OK > Settings > Display > Edit

Wybierz ekran, który chcesz zmienić za pomocą UP lub DOWN i wciśnij OK. Ustaw informacje dla
mrugającego górnego rzędu za pomocą UP lub DOWN a następnie wciśnij OK. Ilość dostępnych
informacji uzależniona jest od dodatków, które są aktywowane. Celem uzyskania dalszych informacji,
przejdź do Ustawienia funkcji (strona 33).

W ten sam sposób zmień rząd środkowy i dolny. Nazwa kazdego ekranu pochodzi od informacji,
wyświetlanej w dolnym rzędzie. Aby powrócić do ustawień domyślnych ekranu, wciśnij i przytrzymaj
LIGHT (kiedy rzędy będą mrugać).

Aktywuj Titles aby przeglądać teksty pomocy podczas zmian ekranu w trakcie treningu: Na ekranie
głównym wybierz OK > Settings > Display > Titles

Informacje na wyświetlaczu Symbol Wyjaśnienie

Godzina Godzina

Odliczanie czasu Odliczanie czasu

Czas okr##enia Numer i czas
okrążenia

Stoper Dotychczasowy
całkowity czas

ćwiczenia

T#tno Aktualne tętno

T#tno #rednie Dotychczasowe
średnie tętno.
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Informacje na wyświetlaczu Symbol Wyjaśnienie

Kalorie Zużycie kalorii /
Zużycie kalorii na

godzine

Zone pointer (Tętno) Jeżeli symbol
serduszka nie jest

widoczny i/lub
słychać alarm,
oznacza to, że

wyszedłeś poza
wyznaczoną strefę

tętna.

Zone pointer (Polar sport zones) Wskaźnik z
symbolem

serduszka, które, w
zależności od

tętna,
przemieszcza się w

lewo i prawo
wewnątrz skali

sport zone, . Celem
uzyskania dalszych

informacji o
ustawieniach stref

sportowych,
przejdź

doFunkcje
przycisków

podczas
ćwiczenia

(strona 20).

Strefa docelowa Wykres pokazujący
zależność
pomiędzy

aktualnym tętnem a
ustawionymi

limitami.

Ró#nica RR Pomiar czasu
pomiędzy

uderzeniami serca,
np. różnica między

dwoma,
następującymi po

sobie, uderzeniami
serca.

Suma wzniesie# Suma pokonanych
wzniesień w

metrach/stopach

Spadek Suma spadków w
metrach/stopach

Wysoko## Aktualna wysokość
n.p.m.
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Informacje na wyświetlaczu Symbol Wyjaśnienie

Czas w strefie Czas spędzony w
strefie

Temperatura Odczyt temperatury
(°C).

Ponieważ ciepło
twojego ciała ma

wpływ na aktualny
odczyt

temperatury,
najlepszym

sposobem na
uzyskanie

optymalnego
pomiaru, jest

zdjęcie odbiornika
z ręki na minimum

10 minut .

Informacje na wyświetlaczu (wymagany jest Polar
s3 sensor W.I.N.D. )

Symbol Wyjaśnienie

Pr#dko##/rytm Aktualna
prędkość/rytm

Maksymalna pr#dko## Dotychczasowa
maksymalna

prędkość i rytm

#rednia pr#dko## Dotychczasowa
średnia prędkość i

rytm

Dystans Dotychczasowy
przebyty dystans

Dystans okr##enia Numer i dystans
okrążenia

Dystans podró#y Dystans pomiędzy
punktami A i B

Zone pointer (prędkość/rytm) Jeżeli symbol nie
jest widoczny i/lub

słychać alarm,
oznacza to, że

wyszedłeś poza
wyznaczoną strefę
prędkości/rytmu.

Kadencja Kadencja biegu
(pary kroków na

minutę)

#rednia kadencja Dotychczasowa
średnia kadencja
(pary kroków na

minutę)
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Informacje na wyświetlaczu (wymagany jest Polar
s3 sensor W.I.N.D. )

Symbol Wyjaśnienie

Zone pointer* (kadencja) Jeżeli symbol
kadencji nie jest
widoczny i/lub
słychać alarm,
oznacza to, że

wyszedłeś poza
wyznaczoną strefę

kadencji.

Informacje na wyświetlaczu (wymagany jest Polar
G3 GPS sensor W.I.N.D. )

Symbol Wyjaśnienie

Pr#dko##/rytm Aktualna
prędkość/rytm Ilość
kresek nad literą G

wskazuje siłę
sygnału sensora

GPS.

Maksymalna pr#dko## Dotychczasowa
maksymalna

prędkość i rytm

#rednia pr#dko## Dotychczasowa
średnia prędkość i

rytm

Dystans Dotychczasowy
przebyty dystans

Dystans okr##enia Numer i dystans
okrążenia

Dystans podró#y Dystans pomiędzy
punktami A i B

Zone pointer (prędkość/rytm) Jeżeli symbol nie
jest widoczny i/lub

słyszysz alarm,
oznacza to, że

wyszedłeś poza
wyznaczoną strefę
prędkości/rytmu.

Informacje na wyświetlaczu (wymagany jest Polar
sensor prędkości W.I.N.D. )

Symbol Wyjaśnienie

Pr#dko## roweru Prędkość, z jaką
aktualnie jedziesz

Dystans Przejechany
dystans

Dystans okr##enia* Numer i dystans
okrążenia

Dystans podró#y Dystans pomiędzy
punktami A i B
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Informacje na wyświetlaczu (wymagany jest Polar
sensor prędkości W.I.N.D. )

Symbol Wyjaśnienie

Maksymalna pr#dko## Dotychczasowa
maksymalna

prędkość.

#rednia pr#dko## Dotychczasowa
średnia prędkość.

Inklinometr Kąt nachylenia
terenu, z góry i pod
górę, w procentach

i stopniach.
Szacowane

odchylenie terenu
pomaga ci

odpowiednio
dostosować

wysiłek.

Informacje na wyświetlaczu (wymagany jest Polar
sensor kadencji W.I.N.D.)

Symbol Wyjaśnienie

Kadencja Mierzy prędkość, z
jaką kręcisz korbą
w swoim rowerze

(kadencja) w
obrotach na minutę

(rpm)

#rednia kadencja Średnia kadencja.

Zone pointer* (kadencja) Jeżeli symbol
kadencji nie jest
widoczny i/lub
słychać alarm,
oznacza to, że

wyszedłeś poza
wyznaczoną strefę

kadencji.

Funkcje przycisków podczas ćwiczenia

Nagrywanie okrążenia
Wciśnij OK aby zapisać okrążenie. Na ekranie zostaną wyświetlone:
Numer okrążenia
Średnie tętno okrążenia
Czas okrążenia

Jeżeli sensor prędkości* jest włączony, następujące opcje będą wyświetlone:
Numer okrążenia
Dystans okrążenia
Średnia prędkość/rytm okrążenia
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Blokada strefy
Jeśli wcześniej nie ustawiłeś stref, możesz, podczas ćwiczenia, zablokować go do odpowiadającej mu
Sport zone. W ten sposób, jeśli nie ustawiłeś założeń strefy przed rozpoczęciem ćwiczenia, możesz to
zrobić podczas sesji.

Aby zablokować lub odblokować strefy, przytrzymaj OK.

Podczas zaprogramowanego ćwiczenia: Wciśnij i przytrzymaj OK oraz wybierz Lock zone/Unlock zone z
Lap menu.

Przykładowo: biegnąc z tętnem na poziomie 130 bmp (co stanowi 75% twojego maksymalnego pulsu)
klasyfikujesz się do strefy 3; możesz przytrzymać OK aby zamknąć swoje tętno w tej strefie. Sport zone3

Locked 70%-79% jest wyświetlone. W przypadku wyjścia poza strefę, niezależnie czy jest to limit górny
czy dolny, odbiornik powiadomi cię o tym sygnałem (jeżeli funkcja target zone alarm jest włączona).
Odblokuj strefę poprzez ponowne przytrzymanie OK: Sport zone3 Unlocked zostanie wyświetlone.

Przy użyciu oprogramowania, możesz również ustawić ZoneLock według swojej prędkości/rytmie lub
kadencji*. Więcej informacji znajdziesz w pomocy programu.

*Opcjonalny sensor jest wymagany.

Powiększenie Wyświetlacza

Wciśnij i przytrzymaj UP aby powiększyć górny rząd, oraz DOWN aby powiększyć środkowy rząd. Powrót
do normalnego wyświetlania poprzez ponowne naciśnięcie i przytrzymanie przycisku.

Podświetlenie ekranu (Night mode on)
Aby podświetlić ekran, wciśnij LIGHT podczas ćwiczenia. Tryb nocny jest włączony; ekran będzie
podświetlany automatycznie gdy jeden z przycisków zostanie naciśnięty lub faza ćwiczenia ulegnie
zmianie.

View Quick Menu
Wciśnij i przytrzymaj LIGHT. Settings zostanie wyświetlone. Niektóre ustawienia możesz zmienić bez
pauzowania zapisu ćwiczenia. Zawartość menu zależy od typu ćwiczenia. Celem uzyskania
dalszychinformacji, przejdź do
• Prev. phase : Streszczenie informacji dotyczących poprzedniego cyklu lub powtórzeń (pokazywane w

przypadku stworzenia w oprogramowaniu ćwiczenia z etapami).
• Keylock: Blokowanie/odblokowanie klawiszy celem uniknięcia przypadkowego naciśnięcia przycisku.
• TZ Alarm: Włącz/wyłącz alarm strefy.
• Change zone: Przełącz zdefiniowaną strefę (wyświetlane wówczas, gdy poza stworzonym w

oprogramowaniu ćwiczeniem z fazami, masz zdefiniowane różne strefy).
• HR view: Wybierz format pokazywania tętna.
• Speed view: Wybierz km/h lub min/km.
• Calibrate : Dokonaj kalibracji stride sensor* (nie wyświetla się jeśli stride sensor jest wyłączony).
• Seek sensor: poszukiwanie sygnału nadajnika WearLink lub sensora, jeżeli, wskutek nieprzewidzianych

zakłóceń, zanikł on podczas ćwiczeń.
• A.Lap*: Włączenie/wyłączenie automatycznych okrążeń.

Po dokonaniu pierwszej zmiany ustawień, odbiornik powróci do ćwiczenia.

Pauza podczas ćwiczenia
Dokonaj pauzy w zapisie ćwiczenia poprzez naciśnięcie STOP.
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Podczas pauzy dostępne są następujące opcje:
• Continue: Kontynuacja zapisu ćwiczenia.
• Exit: Zatrzymanie zapisu ćwiczenia (lub wciśnij STOP).
• Summary: Podsumowanie dotychczasowego ćwiczenia. Wyświetlane są następujące podsumowania:

kalorie,dystans *, czas ćwiczenia, maksymalne tętno, minimalne tętno, średnie tętno, maksymalna
prędkość/rytm*, średnia prędkość/rytm*, wzniesienie terenu i wysokość.

• Combine: Połącz swoje obecne ćwiczenie z poprzednimi.
• Settings: Zmień lub przeglądnij różne ustawienia.
• Reset: Skasuj zapisane informacje o ćwiczenu. Potwierdź za pomocą OK i wciśnij OK ponownie, aby

wznowić zapis.
• Reset trip: Zresetuj dystans wycieczki. Potwierdź za pomocą OK i wciśnij OK ponownie, aby wznowić

zapis.
• Location**: Sprawdź swoją obecną lokalizacje. Odbiornik wskazuje lokalizację na podstawie ostatnich

współrzędnych z sensora GPS. Długość i szerokość geograficzna pokazane są w stopniach i minutach .
Liczba dostępnych satelitów widoczna jest w najniższym rzędzie.

• Free mode: Zmień swój profil ćwiczenia na tryb Free. Wykonywane przez ciebie ćwiczenie nie zostanie
usunięte; będzie natomiast kontynuowane bez ustawień. Zrestartuj oryginalne ćwiczenie pauzując sesję i
wybierając Restart P1.

**Opcjonalny G3 GPS sensor W.I.N.D. jest wymagany.

Wyznaczenie OwnZone
Celem uzyskania dodatkowych informacji o Polar OwnZone®, przejdź do Trening OwnZone (strona 54).

Wyznacz swoją OwnZone podczas rozgrzewki w chodzie/biegu; zajmie ci to około 1-5 minut. Rozpocznij
ćwiczenie powoli, z małą intensywnością; następnie stopniowo zwiększaj tempo.

Wyznacz OwnZone na nowo, gdy:
• Zmieniasz otoczenie treningowe lub dyscyplinę sportu
• Gdy rozpoczynasz ćwiczenia po co najmniej tygodniowej przerwie.
• Jeżeli nie odpocząłeś po ostatniej sesji, nie czujesz się dobrze lub gdy jesteś zestresowany.
• Po zmianie ustawień użytkownika.

Przed wyznaczeniem OwnZone upewnij się, że:
• Ustawienia użytkownika są wprowadzone poprawnie.
• Wybierz ćwiczenie OwnZone. Za każdym razem gdy rozpoczniesz ćwiczenie OwnZone, odbiornik

automatycznie wyznaczy twoją OwnZone.

1. Załóż nadajnik i stride sensor*, zgodnie z wcześniejszymi wskazówkami. Rozpocznij ćwiczenie
dwukrotnie naciskając OK.

2. Gdy zaczniesz ćwiczenie, OZ zostanie wyświetlone i rozpocznie się wyznaczanie OwnZone.

Wyznaczanie Own Zone składa się z 5 części. Po zakończeniu każdej części usłyszysz sygnał
dźwiękowy (jeżeli dźwięk jest włączony).

OZ > Idź wolnym tempem przez 1 minutę. Utrzymuj tętno poniżej 100 bpm / 50% HRmax podczas
pierwszego etapu.

OZ > Idź normalnym tempem przez 1 minutę. Powoli zwiększaj tętno o 10-20 bpm / 5% HR max.

OZ > Idź szybkim tempem przez 1 minutę. Powoli zwiększaj tętno o 10-20 bpm / 5% HR max.

OZ > Biegnij wolnym tempem przez 1 minutę. Powoli zwiększaj tętno o 10-20 bpm / 5% HR max.

OZ >>>>> Biegnij szybkim tempem przez 1 min. Zwiększaj tętno w przybliżeniu o 10 bpm/ 5 % HRmax.

3. W pewnym momencie ćwiczenia usłyszysz dwa, następujące po sobie, sygnały dźwiękowe. Oznacza to,
że wyznaczanie Own Zone zostało zakończone.
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4. Jeżeli wyznaczanie zakończyło się sukcesem, OwnZone Updated i strefa zostaną wyświetlone. Strefa
wyświetlona jest w uderzeniach na minutę (bpm), jako % maksymalnego tętna (HR%) lub jako %
rezerwy tętna (HRR%); w zależności od twoich ustawień.

5. Jeżeli wyznaczanie strefy nie powiedzie się, zostanie użyta twoja ostatnia, wyznaczona strefa i OwnZone

Limits zostanie wyświetlone Jeżeli wcześniej OwnZone nie było zapisywane, pojawią się,
automatycznie, limity wyznaczone na podstawie wieku.

Kontynuuj ćwiczenie. Celem optymalizacji efektów, staraj się ćwiczyć w wyznaczonej strefie.

Alternatywnie, aby pominąć wyznaczanie OwnZone i użyć ostatnio wyznaczonej strefy, naciśnij OK w
którymkolwiek momencie tego procesu.

Czas poświęcony na wyznaczenie Own Zone jest zawarty w czasie zapisanego ćwiczenia.
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6. ZAKOŃCZENIE TRENINGU

Zatrzymanie zapisu
Dokonaj pauzy w zapisie ćwiczenia naciskając STOP. Aby całkowicie zatrzymać zapis ćwiczenia, wciśnij
STOP ponownie.

Dbałość o nadajnik po zakończeniu ćwiczenia. Po każdym treningu odczep nadajnik od elektrod;
elektrody umyj pod bieżącą wodą . Regularnie, co najmiej po pięciu treningach, pierz elektrody w
pralce w temperaturze 40ºC/104ºF. Celem poznania szczegółów dotyczących konserwacji, przejdź do
Konserwacja i przechowywanie (strona 61).

Analiza wyników ćwiczenia

Aby zobaczyć podstawowe informacje na temat swoich wyników, wybierz File. Celem dokładnej analizy,
przenieś dane do Polar ProTrainer 5. Oprogramowanie to oferuje różnorodne opcje analizy danych.

Odbiornik i oprogramowanie łączą się za pomocą IrDA. Najpierw otwórz program. Wybierz Connect w
swoim Polarze; odbiornik połóż naprzeciwko podczerwieni Polar IrDA USB Adapter lub jakiejkolwiek innej
IrDA (kompatybilnej z odbiornikiem). Celem uzyskania pełnej instrukcji dotyczącej przesyłania danych,
przejdź do pomocy oprogramowania.

Wybierz File aby uzyskać następujące opcje:
• Exercise log pokazuje maksymalnie 99 plików z ćwiczeniami
• Weekly zawiera podsumowania z ostatnich 16 tygodni.
• Totals Pokazuje ogólną wartość informacji o ćwiczeniach.
• W Delete menu możesz usuwać pliki z ćwiczeniami.

Exercise Log
Wybierz File > Exercise log
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Detale dotyczące sesji treningowej możesz zobaczyć w Exercise log . Następujące informacje zostaną
wyświetlone:
• Nazwa ćwiczenia.
• Słupek obrazujący dane ćwiczenie. Wysokość słupka wskazuje czas trwania ćwiczenia. Dzięki temu

możesz zobaczyć różnice swoich sesji w postaci wykresu.
• Data wykonania ćwiczenia.

Informacje, które mogą być przeglądane (a-d poniżej), zależą od typu i ustawień ćwiczenia (przykładowo:
jeżeli twoje ćwiczenie nie zawiera faz, to informacje o nich nie zostaną wyświetlone).

Przeglądaj ćwiczenia za pomocą UP lub DOWN ; wciśnij OK aby je otworzyć:

a. G#ówne

Wybierz File > Exercise log > Basic

b. Sport zones

Wybierz File > Exercise log > Sport

zones

c. Fazy

Wybierz File > Exercise log > Phases

d. Okr##enia

Wybierz File > Exercise log > Laps

d. Podsumowanie Multisport

Podsumowanie multisport jest dołączone do
każdego ćwiczenia, będącego częścią
składową połączonych ćwiczeń.
Wybierz File > Exercise log > Multisport

summary

a. Główne

Wybierz File > Exercise log > Basic

Nazwa ćwiczenia
Godzina rozpoczęcia
Dystans*
Czas trwania
* s3, G3 lub speed sensor W.I.N.D. są wymagane.

Wciśnij OK ; aby przeglądać, poruszaj się za pomocą UP lub DOWN.
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Heart rate w uderzeniach na minutę (bpm) / alternatywnie w
procentach tętna maksymalnego (%) lub jako procent rezerwy
twojego tętna.
Tętno maksymalne
Tętno minimalne
Tętno średnie

Target zones (HR / speed / pace) , kolejno strefa 1,
strefa 2, i strefa 3.
Górny limit
Dolny limit

Time in, above, and below zone 03-01-02 (nazwa fazy jest
wyświetlana w zaprogramowanym ćwiczenu).
Czas powyżej strefy
Czas poniżej strefy
Czas w strefie

Calories zużyte podczas ćwiczenia.
Wydatek kaloryczny wskazuje całkowity wysiłek podczas
ćwiczenia.

Pr#dko##/rytm*

Maksymalna prędkość/rytm
Średnia prędkość/rytm
Dystans
Wciśnij i przytrzymaj LIGHT aby przełączyć pomiędzy
prędością a rytmem.
*opcjonalny s3 stride sensor, G3 GPS sensor lub cycling
speed sensor W.I.N.D jest wymagany

Kadencja*
Kadencja maksymalna
Kadencja średnia
* s3 stride sensor lub cadence sensor W.I.N.D. jest
wymagany.

D#ugo## kroku*
Średnia długość kroku
*opcjonalnie s3 stride sensor W.I.N.D. jest wymagany.

Running Index*
Aby otrzymać wartość Running Index, ćwiczenie musi spełniać
pewne wymagania. Celem uzyskania dodatkowych informacji,
przejdź do ???.
* s3 stride sensor lub G3 GPS sensor W.I.N.D. jest wymagany.

Running Index został zaprojektowany tylko dla
sportów biegowych. Przykładowo: opcja nie ma
zastosowania podczas jazdy na rowerze z sensorem
G3.
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Wysoko##

Wysokość maksymalna
Wysokość minimalna
Wysokość średnia

Czas jazdy

Nazwa roweru
Czas jazdy

Wzniesienie/spadek terenu

Suma pokonanych wzniesień w metrach/stopach
Suma spadków terenu w metrach/stopach

Nachylenie*
Maksymalne nachylenie w %
Minimalne nachylenie w stopniach
*Cycling speed sensor W.I.N.D. jest wymagany.

Odchylenie*
Maksymalne odchylenie w %
Minimalne odchylenie w stopniach
*Cycling speed sensor W.I.N.D. jest wymagany.

Temperatura

Maksymalna temperatura oC w stopniach
Minimalna temperatura oC w stopniach
Średnia temperatura oC w stopniach

Wciśnij STOP aby powrócić do ekranu podstawowych informacji.

Dodatkowe informacje podstawowe

Wybierz File > Exercise log Wybierz ćwiczenie przyciskając OK.

Możesz dodać własne informacje o ćwiczeniach lub też je usunąć z File poprzez przytrzymanie LIGHT na
ekranie informacji o ćwiczeniach (widoczna będzie nazwa ćwiczenia).

Aby dodać informacje, wybierz Add info:
• Rank: Nadaje stopień twojemu ćwiczeniu.
• Feeling : Określa twoje subiektywne odczucia podczas treningu.
• Temperat. : Ustaw temperaturę za pomocą UP lub DOWN.
• Distance: Wybierz but lub rower a następnie wprowadź dystans. Dystans będzie zaktualizowany w

ogólnych oraz tygodniowych raportach.

b. Sport zones
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Wybierz File > Exercise log > Sport zones

Na ekranie informacji podstawowych, wciśnij DOWN aby zobaczyć informację o Sport zones.

Wciśnij OK i przewiń UP lub DOWN aby zobaczyć czas, spędzony w każdej ze stref. Różnice twoich sesji
są tu pokazane w formie wykresu.

Wciśnij STOP aby powrócić do widoku informacji o Sport Zones.

c. Fazy

Wybierz File > Exercise log > Phases

Phases menu jest wyświetlane tylko wówczas, gdy ćwiczenie, zawierające fazy, zostalo stworzone za
pomocą oprogramowania.

Przegląd informacji w Sport zones; wciśnij DOWN aby przejrzeć informację o Phases. Możesz przeglądać
każdą fazę osobno.

Przewiń dane wybranej fazy poprzez naciśnięcie OK. Możesz dokonać porównania faz poprzez
naciśnięcie UP lub DOWN.

Czas

Nazwa fazy
Czas podziału
Czas trwania danej fazy

Heart rate w uderzeniach na minutę (bpm); alternatywnie w
procentach tętna maksymalnego (%) lub jako procent rezerwy
Twojego tętna.
Tętno maksymalne
Tętno średnie
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Ró#nica wzrostu HR / Odnowy HR / HR.

Różnica pomiędzy tętnem na początku i na końcu fazy Heart rate
w uderzeniach na minutę (bpm); alternatywnie w procentach tętna
maksymalnego (%) lub jako procent rezerwy Twojego tętna.
Increased HR: Jeżeli tętno na początku fazy było niższe niż na
końcu, odbiornik pokaże róznice w tętnie (tętno końcowe minus
tętno początkowe). Podczas fazy ćwiczenia, odbiornik pokaże
podwyższoną wartość tętna.
Increased HR: Jeżeli tętno na początku fazy było wyższe niż
tętno na końcu, odbiornik pokaże róznice w tętnie (tętno
początkowe minus tętno końcowe). Podczas fazy odpoczynku
odbiornik pokaże odzyskaną wartość tętna.
HR differ: Jeżeli wartość tętna była taka sama na początku fazy
jak i na końcu, odbiornik pokaże różnicę w HR równą 0.

Pr#dko##/rytm*

Maksymalna prędkość/rytm
Średnia prędkość/rytm
* s3 stride sensor, G3 GPS sensor lub cycling speed sensor
W.I.N.D jest wymagany

Dystans*
Podział dystansu
Dystans danej fazy
* s3 stride sensor, G3 GPS sensor lub cycling speed sensor
W.I.N.D jest wymagany

Kadencja*
Kadencja maksymalna
Średnia kadencja aktualnej fazy
* s3 stride sensor lub cadence sensor W.I.N.D. jest wymagany.

D#ugo## kroku*
Średnia długość kroku aktualnej fazy
* s3 stride sensor W.I.N.D. jest wymagany.

Wciśnij STOP aby powrócić do informacji o Phases

d. Okrążenia

Wybierz File > Exercise log > Laps

W informacjach o Phases znajdziesz informację o Laps poprzez naciśnięcie DOWN. Informacje o
okrążeniach pokazane będą tylko wówczas, gdy w pamięci jest więcej niż jedno okrążenie.

Number of recorded laps/autolaps (informacje o zapisanych
okrążeniach i autookrążeniach)
Średni czas okrążenia
Najszybsze okrążenie na przemian z jego czasem.

Ostatnie okrążenie nie jest nigdy wyświetlane jako najlepsze (nawet gdy było najszybsze). Jeżeli jesteś na
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zawodach i nie chcesz, aby ostatnie okrążenie zostało pominięte, po jego zakończeniu, zamiast STOP,
naciśnij OK . W ten sposób ostatnie okrążenie będzie brane pod uwagę w obliczeniu najlepszego okrążenia.
Po osiągnięciu linii mety możesz przerwać zapis.

Przeglądaj informacje o pojedynczym okrążeniu poprzez naciśnięcie OK.

Porównaj informacje o różnych okrążeniach używając UP lub DOWN.

Prosty i czytelny obraz informacji z okrążeń uzyskasz poprzez zgranie ćwiczenia do programu.

Czas

Czas podziału
Czas okrążenia

Heart rate w uderzeniach na minutę (bpm); alternatywnie w procentach tętna
maksymalnego (%) lub jako procent rezerwy Twojego tętna.
Tętno maksymalne
Tętno średnie
Końcowe tętno okrążenia

Pr#dko##/Rytm

Średnia prędkość/rytm
Końcowa prędkość/rytm okrążenia
Wciśnj i przytrzymaj LIGHT aby przełączyć pomiędzy prędością a rytmem.
* s3 stride sensor, G3 GPS sensor lub cycling speed sensor W.I.N.D jest
wymagany

Dystans

Dystans podziału
Dystans okrążenia
* s3 stride sensor, G3 GPS sensor lub cycling speed sensor W.I.N.D jest
wymagany

Kadencja

Maksymalna
Średnia kadencja okrążenia
* s3 stride sensor lub cadence sensor W.I.N.D. jest wymagany.

D#ugo## kroku

Średnia długość kroku okrążenia
* s3 stride sensor W.I.N.D. jest wymagany.

Nachylenie

Nachylenie w %
Nachylenie w stopniach
*Cycling speed sensor W.I.N.D. jest wymagany.
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Wysoko##

Suma wzniesień
Wysokość

Wysoko##

Spadek
Wysokość

Temperatura

Wciśnij STOP aby powrócić do informacji o Okr##eniach

Podsumowanie tygodna
Wybierz File > Weekly

W Weekly summary możesz przeglądać dane z ostatnich 16 tygodni ćwiczeń. Słupek po prawej stronie,
nazwany This week, wyświetla podsumowanie obecnego tygodnia. Wcześniejsze słupki datowane są w
niedzielę każdego tygodnia. Przewijaj wyświetlone tygodnie za pomocą UP lub DOWN ; w dolnym
rzędzie przeglądaj czas trwania ćwiczenia .

Wciśnij OK aby wybrać tydzień i zobaczyć kalorie, dystans i czas ćwiczenia.

Wciśnij DOWN aby zobaczyć tygodniowe podsumowanie Shoes distance, GPS distance i Bikes distance.

Wciśnij DOWN aby zobaczyć tygodniowe strefy.

Aby zobaczyć czas spędzony w każdej strefie, wciśnij OK i przeglądaj strefy za pomocą UP lub DOWN.

Totals
Wybierz File > Totals

Totals zawierają sumaryczne informacje o zapisanych wynikach (od czasu ostatniego resetu).
Wykorzystaj wartości z Totals jako sezonowe lub miesięczne kontrasty plików ćwiczeń. Wartości
uaktualniane są automatycznie; gdy zapis ćwiczenia został zatrzymany.
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Używaj UP lub DOWN aby poruszać się po następujących informacjach:

• Tot. Shoe1 distance

• Tot. Shoe2 distance

• Tot. Shoe3 distance

• Tot. Bike1 distance

• Tot. Bike2 distance

• Tot. Bike3 distance

• Total Shoes distance

• Total GPS distance

• Total Bikes distance

• Total distance

• Ca#kowity czas

• Ca#kowity wydatek energetyczny:

• Ogólny rachunek #wiczenia

• Ca#kowita suma podej##:

• Total odometer (Łączny dystans nie może być zresetowany)

• Reset totals

W celu wyzerowania wartości totals

Wybierz File > Totals > Reset totals

Wybierz z menu wartość, którą chcesz zresetować, i potwierdź za pomocą OK. Aby potwierdzić
zresetowanie, wybierz Yes. Skasowanych danych nie można odzyskać. Wybierz No aby powrócić do
menu Reset.

Kasowanie plików
Wybierz File > Delete

W Delete możesz usunąć wcześniejsze ćwiczenia pojedynczo, wszystkie lub wartości total.

Poruszaj się po następujących informacjach za pomocą UP lub DOWN:
• Exercise : Zaznacz pojedyncze ćwiczenie do usunięcia.
• All exerc. : Usuń wszystkie ćwiczenia z pamięci (naciskając jeden przycisk).
• Totals: Usuń wartości total: pojedynczo lub wszystkie na raz.

Potwierdź naciskając Yes.
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7. USTAWIENIA

Ustawienia funkcji
Nowo zakupiony sensor, jako osobna część, musi zostać dopasowany do odbiornika. Nazywamy to
"uczeniem"; trwa ono zaledwie kilka sekund. "Uczenie" jest gwarancją, że odbiornik odebrał sygnał z
sensora; to z kolei umożliwi ci ćwiczenie w grupie, bez ryzyka zakłóceń przekazu danych. Jeżeli kupiłeś
odbiornik z sensorem w zestawie, sensor został już "nauczony" współpracy z odbiornikiem. Musisz
jedynie aktywować sensor w Polarze .

Dokonując aktywacji sensora w menu feature, Teach new sensor? zostanie wyświetlone. Możesz
"nauczyć" nowy sensor wybierając Yes. Wybierz No jeżeli sensor jest już "nauczony".

Aby "nauczyć" osobno kupiony nadajnik WearLink, przejdź do "Uczenie" nowego nadajnika
(strona ? ).

Polar s3 Stride Sensor W.I.N.D.
Aby aktywować sensor biegowy w swoim odbiorniku, wybierz Settings > Features > Shoes/bikes > Shoe

03-01-02 > On. Teach new sensor? zostanie wyświetlone.

• Jeżeli sensor został już "nauczony", wybierz No.

• Jeżeli sensor nie był jeszcze "nauczony", wybierz Yes.

Przed "nauką" nowego sensora upewnij się, że w odległości (40 m/131 ft) nie ma innego sensora biegowego
lub sensora G3 GPS. Sensor powinien być w obrębie 1,5 meters/5 ft od odbiornika. Przed uczestnictwem w
zawodach upewnij się, że sensor został wcześniej "nauczony". Pozwoli to uniknąć ewentualnych zakłóceń,
które mogłyby wystąpić z uwagi na duży zasięg sensora.

Aby powrócić do ekranu aktualnego czasu, wciśnij i przytrzymaj STOP.

Polar Cycling Speed Sensor W.I.N.D.
Aby aktywować sensor prędkości w swoim odbiorniku, wybierz Settings > Features > Shoes/bikes > Bike

1/2/3 > On > Speed > On. Teach new sensor? zostanie wyświetlone.

• Jeżeli sensor został już "nauczony", wybierz No.

• Przed "nauką" nowego sensora upewnij się, że nikt inny nie używa sensora prędkości w obrębie (40
m/131 ft) i wybierz Yes.
Po wyborze Yes, obróć kilka razy kołem, aby aktywować sensor . Mrugająca, czerwona dioda
sygnalizuje, że sensor jest aktywny . Completed zostanie wyświetlone; oznacza to zakończenie "nauki" .
Odbiornik jest gotowy do odbierania danych o prędkości i dystansie .

Aby powrócić do ekranu aktualnego czasu, wciśnij i przytrzymaj STOP.

Polar Cadence Sensor W.I.N.D.
Aby aktywować sensor kadencji w swoim odbiorniku, wybierz Settings > Features > Shoes/bikes > Bike

1/2/3 > On > Cadence > On. Teach new sensor? zostanie wyświetlone.

• Jeżeli sensor został już "nauczony", wybierz No.

• Przed "nauką" nowego sensora upewnij się, że nikt inny nie używa sensora kadencji w obrębie (40 m/131
ft) i wybierz Yes.
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Po wybraniu Yes, Start test drive zostanie wy#wietlone. Aby aktywować sensor, obróć kilka razy korbą.
Mrugająca, czerwona dioda sygnalizuje, że sensor jest aktywny . Completed zostanie wyświetlone;
oznacza to zakończenie "nauki". Odbiornik jest gotowy do odbioru danych dotyczących kadencji .

Aby powrócić do ekranu aktualnego czasu, wciśnij i przytrzymaj STOP.

G3 GPS sensor W.I.N.D.
Aby aktywować G3 GPS sensor w odbiorniku, wybierz Settings > Features > G3 > OnTeach new sensor?

zostanie wyświetlone.

• Jeżeli sensor został już "nauczony", wybierz No.

• Przed "nauką" nowego sensora upewnij się, że nie ma innego s3 stride sensors lub G3 GPS sensors w
obrębie (40 m/131 ft) i wybierz Yes.

Aby powrócić do ekranu aktualnego czasu, wciśnij i przytrzymaj STOP.

Wysokość
Odbiornik przelicza ciśnienie powietrza na odczyt wysokości. Zmień ustawienia altimetru w menu
Altitude. Możesz dokonać kalibracji altimetru manualnie lub automatycznie.

Włączanie/wyłączanie wysokościomierza

Wybierz Settings > Features > Altitude > On / Off

Ręczna kalibracja wysokościomierza

Wybierz Settings > Features > Altitude > Calibrate > ustaw aktualną wysokość

Jeżeli wysokość, na jakiej przebywasz, różni się znacznie od wyświetlanej na ekranie, Calibrate to xx?

zostanie wyświetlone.
• Yes: Altimetr zostanie skalibrowany do wyświetlanej opcji xx.
• No: Altitude calibration canceled zostanie wyświetlone. Użyta zostanie wysokość, ostatnio zapamiętana

przez odbiornik.

Kalibruj wysokość, aby być pewnym, że wskazania są poprawne. Wprowadź odpowiednią wysokość
zawsze gdy znajdujesz się w miejscu o oznaczonej wysokości np. na szczycie górskim lub na poziomie
morza.

Automatyczna kalibracja wysokościomierza

Wybierz Settings > Features > Altitude > AutoCalib > On / Off

Gdy automatyczna kalibracja jest włączona, ostatnio zapisana w pamięci odbiornika wartość zostanie
użyta podczas ćwiczenia. Funkcja ta jest przydatna wówczas, kiedy zaczynasz ćwiczenie zawsze na tej
samej wysokości. Jeżeli automatyczna kalibracja się nie powiedzie, najprawdopodobniej oznacza to, że
nie startujesz z tego miejsca, co zwykle; musisz w związku z tym dokonać ręcznej kalibracji.

Altitude calibrated to xx m/ft oznacza, że kalibracja została zakończona pomyślnie. Jeżeli Altitude

calibration failed zostanie wyświetlone, ponownie skalibruj altimetr.

Zapis tempa (uśrednianie)
Wybierz Settings > Features > Rec.rate > 1 / 2 / 5 / 15 / 60 sec

Odbiornik może przechowywać tętno, prędkość/rytm* oraz wysokość w odległościach 1, 2, 5, 15 lub 60
sekund. Długi czas uśredniania pozwala na dłuższy zapis, natomiast krótki czas uśredniania pozwala
uzyskać bardziej szczegółowe dane. To z kolei pozwala na dokładniejszą analizę za pomocą
oprogramowania.

Krótszy czas uśredniania dużo szybciej zużywa pamięć odbiornika . W trakcie ustawiania czasu
uśredniania pozostały czas zapisu wyświetlony jest w dolnym rzędzie. Domyślny czas uśredniania
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wynosi 5 sekund

Gdy zostanie mniej niż 30 minut maksymalnego czasu zapisu, czas uśredniania zostanie automatycznie
przedłużony (1s > 2s > 5s > 15s > 60s). Pozwoli to na zapisanie dłuższego ćwiczenia. Po zakończeniu
ćwiczenia, aktualny czas uśredniania zostaje ustawiony jako domyślny.

Poniższa tabela przedstawia czas zapisu w zależności od czasu uśredniania. Czas uśredniania ulega
zmianie w przypadku, jeśli zostało nie więcej niż 30 minut zapisu.

RR-data Prędkość Kadencja S3 GPS Wysokość Czas uśredniania

1s 2s 5s 15s 60s

Off Off Off Off Off Off 67h
40min

135h
20min

338h
30min

1015h
40min

4036h
00min

Off Off Off Off Off On 22h
30min

45h
00min

112h
50min

338h
30min

1354h
20min

Off Off Off Off On Off 5h
30min

11h
10min

28h
10min

78h
00min

312h
30min

Off Off Off Off On On 4h
50min

9h
40min

24h
10min

67h
40min

270h
50min

Off Off Off On Off Off 13h
30min

27h
00min

67h
40min

169h
10min

677h
10min

Off Off Off On Off On 9h
40min

19h
20min

48h
20min

126h
50min

507h
50min

Off Off Off On On Off 5h
10min

10h
20min

26h
00min

72h
30min

290h
10min

Off Off Off On On On 4h
30min

9h
00min

22h
30min

63h
20min

253h
50min

Off Off On Off Off Off 33h
50min

67h
40min

169h
10min

507h
50min

2031h
30min

Off Off On Off Off On 16h
50min

33h
50min

84h
30min

203h
00min

812h
30min

Off Off On Off On Off 5h
10min

10h
20min

26h
00min

72h
30min

290h
10min

Off Off On Off On On 4h
30min

9h
00min

22h
30min

63h
20min

253h
50min

Off On Off Off Off Off 16h
50min

33h
50min

84h
30min

203h
00min

812h
30min

Off On Off Off Off On 11h
10min

22h
30min

56h
20min

145h
00min

580h
20min

Off On Off Off On Off 5h
30min

11h
10min

28h
10min

78h
00min

312h
30min

Off On Off Off On On 4h
50min

9h
40min

24h
10min

67h
40min

270h
50min

Off On On Off Off Off 13h
30min

27h
00min

67h
40min

169h
10min

677h
10min
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RR-data Prędkość Kadencja S3 GPS Wysokość Czas uśredniania

1s 2s 5s 15s 60s

Off On On Off Off On 9h
40min

19h
20min

48h
20min

126h
50min

507h
50min

Off On On Off On Off 5h
10min

10
20min

26h
00min

72h
30min

290h
10min

Off On On Off On On 4h
30min

9h
00min

22h
30min

63h
20min

253h
50min

On Off Off Off Off Off 40h
30min

40h
30min

40h
30min

40h
30min

40h
30min

On Off Off Off Off On 18h
20min

25h
20min

32h
40min

37h
30min

39h
50min

On Off Off Off On Off 5h
20min

9h
20min

17h
30min

27h
20min

36h
10min

On Off Off Off On On 4h
30min

8h
10min

15h
50min

26h
00min

35h
40min

On Off Off On Off Off 11h
50min

18h
20min

27h
20min

33h
50min

38h
40min

On Off Off On Off On 8h
40min

14h
30min

23h
30min

31h
40min

38h
00min

On Off Off On On Off 4h
50min

8h
40min

16h
30min

26h
40min

36h
00min

On Off Off On On On 4h
10min

7h
40min

15h
00min

25h
20min

35h
20min

On Off On Off Off Off 25h
20min

31h
10min

36h
10min

39h
00min

40h
10min

On Off On Off Off On 14h
30min

21h
20min

29h
50min

36h
10min

39h
30min

On Off On Off On Off 4h
50min

8h
40min

16h
30min

26h
40min

36h
00min

On Off On Off On On 4h
10min

7h
40min

15h
00min

25h
20min

35h
20min

On On Off Off Off Off 14h
30min

21h
20min

29h
50min

35h
00min

39h
00min

On On Off Off Off On 10h
00min

16h
10min

25h
20min

32h
40min

38h
20min

On On Off Off On Off 5h
20min

9h
20min

17h
30min

27h
20min

36h
10min

On On Off Off On On 4h
30min

8h
10min

15h
50min

26h
00min

35h
40min

On On On Off Off Off 11h
50min

18h
20min

27h
20min

33h
50min

38h
40min
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RR-data Prędkość Kadencja S3 GPS Wysokość Czas uśredniania

1s 2s 5s 15s 60s

On On On Off Off On 8h
40min

14h
30min

23h
30min

31h
40min

38h
00min

On On On Off On Off 4h
50min

8h
40min

16h
30min

26h
40min

36h
00min

On On On Off On On 4h
10min

7h
40min

15h
00min

25h
20min

35h
20min

** Jest to czas 2 lub większej ilości ćwiczeń. Maksymalny czas trwania jednego ćwiczenia wynosi 99 h 59
min 59 s. Czas zapisu może być krótszy, jeżeli zapisujesz bardzo dużą liczbę krótkich ćwiczeń.

Tabela przedstawia szacowane czasy trwania. Dla RR data, maksymalny czas zapisu zależy od tętna i jego
wahań. Jeżeli podczas ćwiczenia (z fazami) zapisujesz okrążenia, czas zapisu ulegnie zmniejszeniu.

Po zapełnieniu pamięci, zapis nie jest automatycznie wyłączany. Dlatego czas ćwiczenia może być
dłuższy niż czas zapisu.

Funkcja RR Data
Wybierz Settings > Features > RR Data > On / Off

Funkcja zapisu RR data mierzy i zapisuje wahania skurczów serca z dokładnością jednej milisekundy.
Umożliwia to dokonanie, za pomocą oprogramowania, analizy (dokładność 1ms) wahań skurczów serca
(HRV) . Zapis RR data zajmuje pamięć odbiornika, dlatego, podczas ustawienia tej funkcji, pozostały
wolny czas zapisu pokazany jest w dolnym rzędzie wyświetlacza.

Wskazania prędkości
Wybierz Settings > Features > Speed view > km/h (mph) or min/km (min/mi)

Automatyczny zapis okrążeń
Ustawienie automatycznego zapisu okrążeń

Wybierz Settings > Features > A.Lap > On > set the lap distance

Odbiornik będzie automatycznie zapisywać okrążenia. Wybierz Off aby deaktywować.

Wyświetlanie tętna
Wybierz sposób wyświetlania tętna

Wybierz Settings > Features > HR view > HR / HR% / HRR%

Sport zones
Zdefiniuj sport zones w odbiorniku

Wybierz Settings > Features > Sport zones > Sport zone low limit

Ustaw dolny limit sport zone 1 przez naciśnięcie UP lub DOWN. Następnie wciśnij OK. W ten sam
sposób ustaw dolny limit dla każdej ze stref. Podczas ustawienia dolnego limitu, górny limit poprzedniej
strefy wyznaczany jest automatycznie.

Przytrzymaj LIGHT aby przełączać pomiędzy wyświetlaniem stref: HR% (procent z maksymalnego tętna)
BMP (uderzenia serca na minutę) lub HRR% (procent z rezerwy tętna).

Ustawienia te można zmienić w prosty sposób, korzystając z oprogramowania. Więcej informacji znajdziesz w
pomocy programu.
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Ustawienia użytkownika
Wprowadź do odbiornika dokładne dane użytkownika; w ten sposób uzyskasz dokładne informacje o
osiągach.

Aby ustawić informacje o użytkowniku

Wybierz Settings > User

• Weight: Aby zmienić jednostki, wciśnij i przytrzymaj LIGHT
• Height: Aby zmienić jednostki, wciśnij i przytrzymaj LIGHT
• Birthday: dd=dzień, mm=miesiąc, yy=rok
• Sex: Male/Female
• Activity: Top/High/Moderate/Low
• Heart Rate : HRmax, HRsit

• VO2max: Maksymalna wydolność tlenowa

Stopień Aktywności

Stopień aktywności to ocena własnej aktywności fizycznej. Wybierz stopień najlepiej opisujący twoją
aktywność fizyczną w ostatnich trzech miesiącach.
• Top: Ćwiczysz ciężko przynajmniej 5 razy w tygodniu lub trenujesz z założeniem maksymalizacji

wyników
• High: Ćwiczysz ciężko przynajmniej 3 razy tygodniowo, przykładowo: biegasz 20-50 km tygodniowo lub

3-5 godzin w tygodniu przeznaczasz na, wykonywane z porównywalną intensywnością, ćwiczenia.
• Moderate: Regularnie ćwiczysz rekreacyjnie, przykładowo: biegasz 5-10 km tygodniowo lub 1/2-2 godzin

w tygodniu przeznaczasz na, wykonywane z porównywalną intensywnością, ćwiczenia; także w
przypadku, gdy twoja praca wymaga niewielkiej aktywności fizycznej.

• Low: nie ćwiczysz regularnie lub nie są to ciężkie treningi, przykładowo: spacerujesz tylko dla
przyjemności lub ćwiczysz, lecz wykonywane ćwiczenia nie wywołują zmęczenia (nie wywołują zadyszki)

W odbiorniku wartości te są wykorzystywane do przeliczenia wydatku energetycznego.

Heart Rate: HRmax, HRsit

HRmax (maksymalne tętno): jako domyślne ustawione jest HRmax (220 - wiek) ustalone na podstawie
wieku. Jeśli sam ustaliłeś swoje HRmax lub twoje tętno maksymalne zostało ustalone podczas badań,
ustaw swoje HRmax manualnie .

HRsit (Wartość tętna w pozycji siedzącej): Jeśli ustaliłeś swoje HRsit zgodnie z instrukcją, ustaw je. Aby
zobaczyć instrukcję, przejdź do???.

Maksymalny pobór tlenu VO2max

VO2max jest to maksymalna ilość tlenu, jaka może być przyswojona, podczas maksymalnego wysiłku,
przez organizm. Najbardziej dokładny sposób na wyznaczenie VO2max to, przeprowadzony przy
najwyższym wysiłku, test. Jeżeli znasz swoje, wyznaczone podczas badania, VO2max, wprowadź jego
wartość do odbiornika. W innym przypadku, określ przybliżoną wartość OwnIndex poprzez wykonanie
Polar Fitness Test. Celem uzyskania dodatkowych informacji, przejdź do ???.

Jeżeli nastąpią zmiany w ustawieniach użytkownika, User settings updated zostanie wyświetlone.

Ustawienia te możesz w prosty sposób zmienić przy pomocy oprogramowania. Więcej informacji w pomocy
programu.
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Ustawienia podstawowe

Dźwięk
W celu ustawienia poziomu dźwięku

Wybierz Settings > General > Sound > Volume > On / Off

Ustaw poziom dźwięku przycisków oraz potwierdzeń podczas ćwiczenia Ustawienie to nie ma wpływu na
funkcje budzika i alarmu przekroczenia stref (TZ Alarm).

Aby włączyć/wyłączyć alarm przekroczenia strefy

Wybierz Settings > General > Sound > TZ Alarm > On / Off

W momencie wyjścia poza strefę zostanie wyłączony alarm i będą świecić się limity. Gdy dźwięki są
wyłączone, ale TZ Alarm wciąż pozostaje włączony, to TZ Alarm będzie nadal działać.

Keylock
Ustawienie blokady przycisków

Wybierz Settings > General > Keylock > Manual / Automatic

Blokada przycisków chroni przed ich przypadkowym przyciskaniem.
• Manual: Ręczne aktywowanie blokady klawiszy. Aby włączyć lub wyłączyć blokadę klawiszy, wciśnij i

przynajmniej przez jedną sekundę przytrzymaj LIGHT .
• Automatic: Blokada klawiszy jest aktywowana automatycznie wówczas, gdy na ekranie aktualnego czasu

nie używano przycisków przez conajmniej jedną minutę

Jednostki
Ustaw preferowane jednostki w odbiorniku.

Wybierz Settings > General > Units > kg/cm/km or lb/ft/mi

Język
Wybór języka

Wybierz Settings > General > Language > English / Deutsch / Español / Français / Italian

Sleep
Aktywuj funkcję sleep

Wybierz Settings > General > Sleep > Activate sleep mode? > Yes

Aktywacja trybu sleep pomaga oszczędzać baterię w sytuacji, gdy odbiornik przez długi okres czasu nie
jest używany . Działanie budzika jest niezależne od aktywacji funkcji sleep.

Ponowne włączenie odbiornika.

Wciśnij jakikolwiek przycisk > Turn display on? > Yes / No

• Yes: odbiornik zostanie aktywowany.
• No: odbiornik powróci do trybu sleep.

Ustawienia te można zmienić w prosty sposób, korzystając z oprogramowania.. Więcej informacji znajdziesz w
pomocy programu.
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Ustawienia zegarka

Przypomnienia
Ustaw tę funkcję, aby nie zapomnieć o ćwiczeniu lub innej czynności.

Wybierz Settings > Watch > Reminders > Add new

• Date: Wprowadź datę zdarzenia, dd=dzień, mm=miesiąc, yy=rok.
• Reminder time : Wpisz godzinę zdarzenia.
• Alarm: Ustaw alarm tak, aby dzwonił o wskazanej godzinie lub 10 min / 30 min / 60 minut przed

zaplanowanym zadaniem.
• Sound: Wybierz typ alarmu Cichy / Sygnał / Normalny.
• Repeat : Wybierz częstotliwość zdarzenia Raz / Co godzinę / Codziennie / Tygodniowo / Miesięcznie /

Rocznie.
• Exercise : Wybierz ćwiczenie, które chcesz mieć przypominane. Gdy funkcja przypomnienia zostanie

wyłączona, odbiornik ustawi to ćwiczenie jako domyślne. Wybierz NONE jeśli nie chcesz przy danym
ćwiczeniu skorzystać z opcji przypomnienia.

• Rename: Aby zmienić nazwę wydarzenia, wybierz litery przy pomocy UP lub DOWN i zatwierdzaj je
przyciskiem OK.

W odbiorniku możesz zaprogramować siedem zdarzeń.

Podgląd aktywnych przypomnień i ich modyfikacja

Wybierz Settings > Watch > Reminders

Wybierz przypomnienie, które chcesz obejrzeć, edytować lub usunąć.

Wydarzenie
Ustaw w odbiorniku funkcję odliczania pozostałego, do wydarzenia, czasu.

Wybierz Settings > Watch > Event

Event day: dd=dzień, mm=miesiąc.

Rename: Aby zmienić nazwę wydarzenia, wybierz litery przy pomocy UP lub DOWN i zatwierdzaj je
przyciskiem OK.

Modyfikacja odliczania dni do wydarzenia

Wybierz Settings > Watch > Event

Wydarzenie można wyświetlić, zmienić jego datę, nazwę lub go usunąć.

Na ekranie z godziną, poprzez wciśnięcie i przytrzymanie przycisku UP, możesz ponownie schować lub
wyświetlić odliczanie.

Alarm
Ustaw alarm/budzik w swoim Polarze

Wybierz Settings > Watch > Alarm > Off / Once / Mon-Fri / Daily

Opcja budzika może być wyłączona lub ustawiona jako aktywna w przedziale od poniedziałku do piątku
lub codziennie. Alarm będzie dzwonić we wszystkich trybach, za wyjątkiem trybu ćwiczenia; będzie
dzwonić przez minutę, chyba, że naciśniesz STOP. Alarm jest aktywny również w trybie sleep. Alarm
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będzie dzwonić także wówczas, gdy wyłączysz dźwięk w ustawieniach General .

Aby ustawić drzemkę na dodatkowe 10 minut, wciśnij UP , DOWN lub OK: Snooze zostanie wyświetlone i
rozpocznie się odliczanie drzemki. Aby wyłączyć drzemkę i alarm, wciśnij STOP.

Jeżeli na wyświetlaczu pojawi się symbol baterii, budzik nie będzie aktywowany

Czas
Ustaw czas 1 w odbiorniku

Wybierz Settings > Watch > Time 1 > 24h / 12h

Ustaw czas 2 w odbiorniku

Wybierz Settings > Watch > Time 2

Wprowadź różnicę godzin między czasem 1 a 2.

Przełączanie pomiędzy ustawionymi godzinami

Wybierz Settings > Watch > Time zone > Time 1 / Time 2

Wybierz strefę czasową

Na ekranie głównym; zmień strefę czasową poprzez wciśnięcie i przytrzymanie DOWN. Wyświetlanie
czasu 2 sygnalizuje numer 2 w prawym dolnym rogu ekranu.

Data
Ustaw datę w odbiorniku

Wybierz Settings > Watch > Event

dd=dzień, mm=miesiąc, yy=rok

Ustawienia te możesz w prosty sposób zmienić przy pomocy oprogramowania. Więcej informacji znajdziesz w
pomocy programu.

Szybkie wybieranie (Quick Menu)
Niektóre funkcje można wybrać poprzez skrót klawiszowy z menu głównego.

Przytrzymaj LIGHT > Quick menu

• Keylock

• Przypomnienia

• Alarm

• Strefa czasowa

• Sleep
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8. PROGRAM TRENINGOWY

Przeglądanie programu
Przy pomocy programu Polar ProTrainer 5 możesz stworzyć własny, lub wykorzystać gotowy,
spersonalizowany zestaw ćwiczeń na swojego Polara. W rozdziale tym znajdziesz podstawowe
wskazówki dotyczące nawigacji i zarządzania programem (gdy prześlesz go już na swój odbiornik). Aby
uzyskać więcej informacji na temat: tworzenie zestawu ćwiczeń za pomocą oprogramowania,
przenoszenie ich na odbiornik, analiza danych po zakończeniu treningu - przejdź do pliku pomocy
oprogramowania Polar ProTrainer 5.

Po przeniesieniu zestawu ćwiczeń; w twoim odbiorniku, celem przeglądania i sprawdzania dziennego
planu treningowego, zostaną utworzone dwa specjalne menu. Przewijanie tygodni, dni oraz ćwiczeń
odbywa się za pomocą UP lub DOWN. Wybierz tydzień i dzień a następnie naciśnij OK.

Przeglądanie planu na dany tydzień

Wybierz Program > Week view

Week view umożliwia przejrzenie ćwiczeń z danego tygodnia. Biały kolor słupka prezentuje planowany
czas ćwiczenia, czarny kolor - czas przeprowadzonego ćwiczenia . Poniżej słupków pokazany jest
docelowy czas ćwiczeń danego tygodnia.

Wciśnij i przytrzymaj LIGHT aby przeglądać następujące informacje tygodniowe.
• Week info: Opis i nazwa tygodnia.
• Targets: Podsumowanie założeń tygodniowych. Kalorie, dystans* oraz czas trwania. Planowany czas

treningu w strefach: wciśnij OK i przeglądaj strefy za pomocą UP lub DOWN.
• Results: Podsumowanie rezultatów danego tygodnia. Kalorie, dystans* i czas trwania. Uzyskany czas w

strefach: wciśnij OK i przeglądaj strefy za pomocą UP lub DOWN.
• Reminder : Ustaw alarm (na określoną godzinę, 10 min, 30 min lub 60 minut przed ćwiczeniem) oraz typ

dźwięku (Cichy, Sygnał, Normalny).
• Program off : Usuwa program z odbiornika.

Podgląd planu na dany dzień

Wybierz Program > Week view > Day view

Wybierz Today > Exercise view

Day view umożliwia przejrzenie ćwiczeń z danego dnia. Biały kolor słupka prezentuje planowany czas
ćwiczenia, czarny kolor - czas przeprowadzonego ćwiczenia . Poniżej słupków pokazany jest docelowy
czas ćwiczeń danego dnia.

Wciśnij i przytrzymaj LIGHT aby zobaczyć dodatkowe informacjie o dniu:
• Targets: Podsumowanie założeń dziennych. Kalorie, dystans* i czas trwania. Planowany czas treningu w

strefach: wciśnij OK i przeglądaj strefy za pomocą UP lub DOWN.
• Results: Podsumowanie rezultatów danego dnia. Kalorie, dystans* i czas trwania. Uzyskany czas w
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strefach: wciśnij OK i przeglądaj strefy za pomocą UP lub DOWN.

Podgląd ćwiczeń z danego dnia

Wybierz Program > Week view > Day view >Exercise view

Wyświetlona zostanie nazwa, opis i docelowy czas trwania ćwiczenia.

Wciśnij i przytrzymaj LIGHT aby przeglądać następujące informacje:
• Targets: Podsumowanie założeń dla sesji treningowej. Kalorie, dystans* oraz czas trwania. Planowany

czas treningu w strefach: wciśnij OK i przeglądaj strefy za pomocą UP lub DOWN.
• Phases: Podsumowanie faz podczas sesji treningowej.
• Sport profile: Przeglądaj nazwę wybranego profilu. Więcej informacji znajdziesz w pomocy programu.
• Reminder : Ustawienie czasu przypomnienia.

*opcjonalny s3 stride sensor, G3 GPS sensor lub cycling speed sensor W.I.N.D jest wymagany

Wykonywanie Zaprogramowanych Ćwiczeń

Rozpoczęcie treningu
Jeśli ustawiłeś przypomnienie, odbiornik przypomni ci o ćwiczeniu, zgodnie z ustawioną w przypomnieniu
datą. Po wyłączeniu przypomnienia naciśnij OK, aby sprawdzić jak wygląda zaplanowane ćwiczenie.

Rozpoczęcie ćwiczenia

Wybierz Today > Exercise view > Wciśnij OK > Wciśnij OK

Wybierz Program > Week view > Day view > Exercise view > Wciśnij OK > Wciśnij OK

Aby uzyskać więcej informacji na temat zapisywania ćwiczeń, przejdź doRozpoczęcie treningu
(strona 13). Twój Polar poprowadzi cię przez sesje treningową.

Ćwiczenie z fazami
Poniżej znajduje się przykład ćwiczenia interwałowego, składającego się z 4 faz:

Warm up / P1: Biegnij 10 minut utrzymując tętno między 55-65% swojego tętna maksymalnego.

Interval / P2: Biegnij 3 km w rytmie pomiędzy 3:30-4:00 min/km.

Recovery / P3: Po 3 km pozwól aby twoje tętno opadło do 120 bpm. Powtórz fazę 2 i 3 po 6 razy.

Cool down / P4: Biegnij 10 minut w rytmie pomiędzy 5:00-6:00 min/km.

Wygląd ekranu podczas ćwiczenia
Podczas ćwiczenia ekran może wyglądać następująco:

Każda faza rozpoczyna się ekranem, na którym zawarte są:
Nazwa fazy
Zone type (Typ Strefy)
Limity strefy
Ilość powtórzeń pozostałych do realizacji

Podczas ćwiczenia wyświetlane są:
Odliczanie czasu/prędkości*, stoper, numer fazy
Strefa docelowa jako wykres (odświeżany co 10 sek, obrazujący ostatnie 8 minut
ćwiczenia)
Tętno
Ilość powtórzeń pozostałych do realizacji
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Każda faza kończy się wyświetleniem następujących informacji:
Czas trwania lub dystans*
Różnica tętna (wzrost lub spadek tętna podczas fazy) lub średnia prędkość/rytm
Tętno średnie
Numer zakończonej fazy

Po zakończeniu ćwiczenia z fazami na ekranie pojawia się informacja o jego
wykonaniu.
Odbiornik ustawia tryb Free; możesz kontynuować ćwiczenie bez ustawień.
Ćwiczenie jest zapisywane do momentu jego wyłączenia.

Aby uzyskać więcej informacji na temat planowania, za pomocą programu, sesji treningowych oraz
przenoszenia ich do odbiornika, przejdź do pliku pomocy oprogramowania.

Funkcje, dostępne podczas ćwiczenia
Te same ustawienia możesz zmieniać zarówno w zaprogramowanych, jak i jakichkolwiek innych tego
typu, ćwiczeniach. Aby uzyskać więcej informacji o dostępności różnych funkcji podczas ćwiczeń, przejdź
doFunkcje przycisków podczas ćwiczenia (strona 20).

Zaprogramowane ćwiczenia korzystają z, ustawionych w oprogramowaniu, profili sportowych. Jeśli
zmienisz ustawienia odbiornika podczas ćwiczenia (np. faktor kalibracji), zmiany nastąpią jedynie w
aktualnym ćwiczeniu Gdy ponownie włączysz to samo ćwiczenie, odbiornik użyje profilu zdefiniowanego
w oprogramowaniu

Lap menu
W celu wyświetlenia Lap menu podczas zaprogramowanego ćwiczenia, naciśnij i przytrzymaj OK.
Przewijaj między opcjami za pomocą UP lub DOWN ; wybierz używając OK. Zawartość Lap Menu jest
uzależniona od twojego ćwiczenia
• End phase: Kończy aktualną fazę ćwiczenia i przechodzi do kolejnej.
• Jump to: Przejdź do którejkolwiek fazy ćwiczenia.
• Lock zone or Unlock zone: Zablokowanie tętna lub prędkości/rytmu* dla danej strefy (jeśli ćwiczysz bez

bieżących założeń).

Przeglądanie wyników ćwiczenia

Wybierz File > Exercise log

Po zakończeniu zaprogramowanego ćwiczenia, pliki zostaną zapisane w folderze File. Celem uzyskania
dalszych informacji, przejdź do Analiza wyników ćwiczenia (strona 24).

*Opcjonalny s3 stride sensor, G3 GPS sensor lub cycling speed sensor W.I.N.D jest wymagany
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9. TESTY

Polar Fitness TestTM

Polar Fitness Test TM jest prostym, bezpiecznym i szybkim sposobem na zmierzenie wydajności
wydolnościowo-tlenowej układu krążenia w spoczynku. Wynik testu nazywany jest OwnIndex. OwnIndex
jest porównywalny do maksymalnego pułapu tlenowego (VO 2max), który jest przyjęty jako pomiar
wydolności tlenowej, wykorzystywanej przy określeniu sprawności fizycznej. Na twój wynik testu
OwnIndex mają wpływ: poziom aktywności fizycznej (w skali długoterminowej), tętno, wahania tętna w
stanie spoczynku, płeć, wiek, wzrost oraz waga. Polar Fitness Test jest przeznaczony dla zdrowych osób
dorosłych.

Pozwala on ocenić zdolność organizmu oraz szybkość, z jaką tlen transportowany jest do mięśni. Im
lepsza wydajność tlenowa, tym bardziej silne i wydajne jest twoje serce. Wysoka wydajność tlenowa
korzystnie wpływa na zdrowie. Przykładowo; pomaga obniżyć wysokie ciśnienie krwi zmniejszając tym
samym ryzyko problemów zdrowotnych z nim związanych. Jeżeli chcesz zwiększyć swoją wydajność
tlenową, musisz ćwiczyć regularnie, średnio 6 tygodni (wpłynie to zauważalnie na OwnIndex). Osoby
mniej wytrenowane zauważą zmiany jeszcze szybciej. Im lepszą masz kondycję, tym wolniej zauważysz
zmiany OwnIndexu.

Najszybszy wzrost wydolności tlenowej następuje podczas uprawiania sportów angażujących duże partie
mięśni. Są to m.in bieganie, kolarstwo, chód, pływanie, jazda na rolkach i łyżwach, narciarstwo biegowe.

Rozpoczynając pomiar, w ciągu pierwszych 2 tygodni wyznacz OwnIndex kilkakrotnie; uśredniając wyniki
wyznaczysz poziom wyjściowy. Potem OwnIndex można wyznaczać mniej więcej raz na miesiąc.

Dzięki Polar Fitness Test możesz również obliczyć maksymalną, przewidywalną pracę serce (HR max-p).
Wynik HRmax-p określa maksymalne tętno bardzie precyzyjnie niż formuła bazująca na wieku (220 -
wiek). Aby uzyskać więcej informacji na temat HRmax, przejdź doUstawienia użytkownika (strona 38).

Aby pomiar był optymalny, musisz spełnić następujące warunki:
• Test można wykonać gdziekolwiek (dom, praca, siłownia) pod warunkiem, że nic nie będzie cię

rozpraszać. Nie ma żadnych niepokojących dźwięków (np. telewizja, radio, telefon), z nikim nie
rozmawiasz.

• Zawsze wykonuj test w tych samych warunkach i o tej samej porze.
• Unikaj ciężkich posiłków i nie pal na 2-3 godziny przed rozpoczęciem testu.
• Zarówno dzień wcześniej jak i w dniu, podczas którego przeprowadzasz test, unikaj stresu, alkoholu oraz

zażywania zbędnych lekarstw.
• Powinieneś być zrelaksowany i spokojny. Połóż się i wycisz na 1-3 minut przed testem.

Przed wykonaniem testu
Załóuż nadajnik

Celem uzyskania dalszych informacji, przejdź do Zakładanie nadajnika (strona 13).

Wprowadź dane o użytkowniku

Wybierz Settings > User

Aby przeprowadzić Polar Fitness Test, w ustawieniach User Settings wprowadź dane użytkownika oraz
ustaw poziom długoterminowej aktywności fizycznej.
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Włącz HRmax-p

Jeżeli chcesz otrzymać wartość przewidywalnego tętna maksymanlego, włącz HRmax-p.

Wybierz Test > Fitness > HR max-p > On

Przeprowadzenie testu
Wybierz Test > Fitness > Start > Fitness Test Lie Down

Fitness test rozpocznie się za 5 sekund. Strzałki oznaczają rozpoczęcie testu.. Zrelaksuj się; ogranicz
ruchy ciała oraz komunikację z inymi osobami.

Jeżeli w ustawieniach użytkownika nie wpisałeś długoteminowego poziomu aktywności fizycznej, Set

your personal activity level zostanie wyświetlone. Wybierz Top, High, Moderate , lub Low. Aby otrzymać
więcej informacji na temat poziomów aktywności fizycznej, przejdź doUstawienia użytkownika
(strona 38).

Jeżeli odbiornik nie odnajdzie sygnału nadajnika na początku lub podczas testu, test zostanie
zatrzymany i wyświetli się komunikat Test failed, check WearLink . Sprawdź wówczas czy elektrody są
dobrze zwilżone i czy dokładnie przylegają do ciała; rozpocznij test ponownie.

Podwójny sygnał dźwiękowy poinformuje cię o zakończeniu testu. OwnIndex wyświetlany jest jako wartość
numeryczna oraz stopień oszacowania. Aby uzyskać więcej informacji na temat oszacowań, przejdź do
Klasyfikacja poziomu wytrenowania organizmu.

Aby wyświetlić wartość Przewidywanego t#tna maksymalnego wciśnij DOWN. Wciśnij OK aby wyjść.

Update to VO2 max?

• Wybierz Yes aby zapisać wartość OwnIndex w ustawieniach użytkownika oraz Fitness Test Trend menu.
• Wybierz No tylko wówczas, gdy znasz swoje, przebadane, VO2max , oraz gdy różni się ono więcej niż

jeden stopień wytrenowania od wyniku OwnIndex. Wartość wyniku OwnIndex jest zapisana tylko w
Fitness Test Trend menu. Celem uzyskania dalszych informacji, przejdź do Fitness Test Trend .

Uaktualni# do HR max? (Jeśli HRmax-p jest włączone)
• Wybierz Yes aby zapisać wartość do ustawień użytkownika.
• Wybierz No w przypadku gdy znasz swoje HRmax.

Test możesz zatrzymać w każdej chwili poprzez naciśnięcie STOP. Fitness Test canceled zostanie
wyświetlone po kilku sekundach

Po zapisaniu wartości OwnIndex oraz HRmax-p, zostaną one użyte do obliczenia zużycia kalorii.

Po wykonaniu testu
Klasyfikacja poziomu wytrenowania organizmu

OwnIndex jest najbardziej miarodajny, kiedy porównujemy jego zmiany na przestrzeni czasu. OwnIndex
można też interpretować na podstawie wieku i płci. Zlokalizuj swój OwnIndex w poniższej tabeli i
porównaj swoją wydolność z osobami twojej płci i w twoim wieku.

Najlepsi sportowcy zwykle uzyskują OwnIndex o wartości 70 (mężczyźni) i 60 (kobiety). Uprawiający
sporty wytrzymałościowe na poziomie olimpijskim mogą nawet uzyskać wartość 95. Najwyższy wskaźnik
OwnIndex występuje przy uprawianiu sportów angażujących duże grupy mięśni, takich jak bieganie czy
narciarstwo biegowe.

Mężczyźni

Wiek / Lata Bardzo
słabo

Słabo Dostatecznie Średnio Dobrze Bardzo
dobrze

Celująco

20-24 < 32 32-37 38-43 44-50 51-56 57-62 > 62

POLSKI

46 TESTY



Wiek / Lata Bardzo
słabo

Słabo Dostatecznie Średnio Dobrze Bardzo
dobrze

Celująco

25-29 < 31 31-35 36-42 43-48 49-53 54-59 > 59

30-34 < 29 29-34 35-40 41-45 46-51 52-56 > 56

35-39 < 28 28-32 33-38 39-43 44-48 49-54 > 54

40-44 < 26 26-31 32-35 36-41 42-46 47-51 > 51

45-49 < 25 25-29 30-34 35-39 40-43 44-48 > 48

50-54 < 24 24-27 28-32 33-36 37-41 42-46 > 46

55-59 < 22 22-26 27-30 31-34 35-39 40-43 > 43

60-65 < 21 21-24 25-28 29-32 33-36 37-40 > 40

Kobiety

Wiek / Lata Bardzo
słabo

Słabo Dostatecznie Średnio Dobrze Bardzo
dobrze

Celująco

20-24 < 27 27-31 32-36 37-41 42-46 47-51 > 51

25-29 < 26 26-30 31-35 36-40 41-44 45-49 > 49

30-34 < 25 25-29 30-33 34-37 38-42 43-46 > 46

35-39 < 24 24-27 28-31 32-35 36-40 41-44 > 44

40-44 < 22 22-25 26-29 30-33 34-37 38-41 > 41

45-49 < 21 21-23 24-27 28-31 32-35 36-38 > 38

50-54 < 19 19-22 23-25 26-29 30-32 33-36 > 36

55-59 < 18 18-20 21-23 24-27 28-30 31-33 > 33

60-65 < 16 16-18 19-21 22-24 25-27 28-30 > 30

Klasyfikacja ta powstała w oparciu o przegląd literatury 62 badań, gdzie VO2max było mierzone
bezpośrednio u zdrowych, dorosłych ludzi w USA, Kanadzie oraz w siedmiu krajach Europy. Źródło:
Shvartz E, Reibold RC. Normy sprawności fizycznej dla mężczyzn i kobiet w wieku od 6 do 75 lat:
Omówienie. Aviat Space Environ Med ; 61:3-11, 1990.

Fitness Test Trend

Wybierz Test > Fitness > Trend

W Trend menu możesz sprawdzić w jaki sposób rozwija się twoja wartość OwnIndex. Wyświetlane są
poszczególne daty i wartości OwnIndex (maksymalnie 16 wartości). Gdy pliki test trend będą pełne,
najstarsze z nich zostaną automatycznie usunięte.

Wyświetlony zostanie najnowszy pomiar wraz z datą oraz wykres wartości OwnIndex. Przewiń UP lub
DOWN aby przeglądnąć inne wartości.

Usuń wartości OwnIndex.

Wybierz Test > Fitness > Trend

Wybierz wartość, którą chcesz usunąć i przytrzymaj LIGHT > Delete value? No/Yes zostanie
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wyświetlone. Potwierdź za pomocą OK.

Analiza rezultatów OwnIndex za pomocą oprogramowania.

Zgranie wyników do programu umożliwia wszechstronną analizę wyników jak również dostęp do bardziej
szczegółowych informacji o twoich postępach. Oprogramowanie umożliwia również stworzenie wykresu
porównującego wcześniejsze wyniki.

Polar OwnOptimizerTM

Podstawy
Efektywny trening wymaga zwiększania: czasu trwania ćwiczenia, intensywności, niekiedy też
całkowitego czasu ćwiczeń w danym okresie. W celu uniknięcia przetrenowania, po każdym ciężkim
treningu musi nastąpić odpowiednio długi odpoczynek. Jeżeli czas odpoczynku będzie niewłaściwy,
możesz doświadczyć spadku formy zamiast jej wzrostu. Polar OwnOptimizer jest prostym i wiarygodnym
testem, który określi czy dany program treningowy optymalnie rozwija twoją formę. Polar OwnOptimizer
mogą wykonać zdrowe osoby dorosłe.

Polar OwnOptimizer jest modyfikacją tradycyjnego testu przetrenowania. Wprowadzony do odbiornika,
idealny dla każdego, kto ćwiczy regularnie przynajmniej trzy razy w tygodniu celem poprawy kondycji i
maksymalizacji osiąganych wyników treningowych. Test ten jest oparty na pomiarze tętna i jego wahań
podczas testu ortostatycznego (podnoszenie się z pozycji leżącej do pozycji stojącej). OwnOptimizer
pomaga zoptymalizować obciążenie treningami podczas realizacji programu treningowego tak, aby
następował stały wzrost formy i nie dochodziło do przetrenowania. Polar OwnOptimizer oparty jest na
pomiarze pięciu parametrów tętna. Dwa z nich określane są podczas leżenia, jeden podczas wstawania i
kolejne dwa w pozycji stojącej Za każdym razem gdy wykonujesz test, odbiornik zapisuje tętno i
porównuje je z poprzednio zarejestrowanymi danymi.

Przed wykonaniem testu
Baseline Tests

Rozpoczynając OwnOptimizer, aby wyznaczyć indywidualną wartość wyjściową, należy wykonać 6
testów w przeciągu 2 tygodni. Pomiarów tych należy dokonać podczas 2 zwykłych tygodni treningowych
(warunek konieczny: umiarkowany wysiłek). Pomiary powinny być przeprowadzone następnego dnia po
treningu oraz po dniach odpoczynku.

Obserwacja wartości OwnIndexu

Po ustaleniu wartości wyjściowej, test należy wykonywać 2-3 razy w tygodniu. Test wykonuj rano,
pierwszy po dniach odpoczynku, drugi - następnego dnia po ciężkim treningu (lub serii ciężkich
treningów). Trzeci test możesz wykonać rano po dniu, w którym wykonałeś zwykłe ćwiczenie.
OwnOptimizer może okazać się niedokładny zarówno w przypadku przetrenowania jak i bardzo
nieregularnych treningów. Jeżeli przerwa w treningach wyniosła więcej niż 14 dni, ponownie powinieneś
wyznaczyć wartość wyjściową.

Przeprowadzenie testu
W celu uzyskania wiarygodnych wyników, test powinien być przeprowadzany zawsze w podobnych
warunkach. Zaleca się przeprowadzenie testu rano, przed śniadaniem. Podstawowe wymogi dotyczące
przeprowadzenia testu:
• Załóż nadajnik
• Zrelaksuj się i wycisz.
• Usiądź wygodnie, lub, jeśli wolisz, połóż się na łóżku. Zawsze wykonuj test w takiej samej pozycji.
• Test można wykonać gdziekolwiek (dom, praca, siłownia) pod warunkiem, że w miejscu tym panuje
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spokój. Nie ma rozpraszających cię dźwięków (np. telewizja, radio, telefon) ani też nikt z tobą nie
rozmawia.

• Unikaj ciężkich posiłków, picia alkoholu oraz palenia na 2-3 godziny przed rozpoczęciem testu.

Przeprowadzenie testu

Wybierz Test > Optimizer > Start > Optimizer Lie Down

Strzałki wskazują rozpoczęcie testu. Nie ruszaj się podczas pierwszych 3 minut testu.

Po upływie 3 minut, odbiornik da ci znać dźwiękiem; wyświetlony zostanie komunikat Optimizer Stand up .
Wstań i stój nieruchomo przez 3 minuty.

Po upływie 3 minut odbiornik ponownie wyda sygnał dźwiękowy i zakończy test.

Wynik pojawi się jako numer wraz z jego interpretacją. Wciśnij DOWN aby zobaczyć średnie tętno (bpm)
podczas leżenia (HRrest), najwyższe tętno podczas wstawania (HRpeak) oraz średnie tętno w pozycji
stojącej (HRstand).

Wykonywanie testu możesz przerwać w dowolnej fazie, naciskając STOP. Optimizer Test canceled

zostanie wyświetlone.

Jeżeli odbiornik nie może odczytać sygnału tętna, pojawi się komunikat Test failed. Check WearLink

zostanie wyświetlone. W tej sytuacji powinieneś sprawdzić czy elektrody są dobrze zwilżone oraz czy
dokładnie przylegają do ciała.

Po wykonaniu testu
Jak interpretować wyniki

Odbiornik oblicza pięć parametrów na podstawie tętna i jego wahań. Wartość OwnOptimizer jest
obliczana poprzez porównanie otrzymanych wyników z poprzednimi. Odbiornik wyświetli opis stanu
twojego wytrenowania. Rozwinięcia tych opisów są przedstawione poniżej.

Good Recovery (1)

Twoje tętno jest niższe niż zwykle. Oznacza to, że bardzo dobrze się zregenerowałeś. Możesz
kontynuować trening, wykonując nawet intensywne ćwiczenia.

Normal State (2)

Twoje tętno jest na normalnym poziomie. Kontynuuj trening; wykonuj intensywne i lekkie ćwiczenia, nie
zapominając o dniach odpoczynku.

Training Effect (3)

Twoje tętno jest niższe niż zwykle. Najprawdopodobniej w ostatnich dniach intensywnie ćwiczyłeś . Masz
dwie opcje: 1) odpocznij, ewentualnie trenuj lekko przez jeden lub dwa dni, albo 2) kontynuuj intensywne
treningi przez jeden lub dwa dni, a następnie dobrze odpocznij. Podobne symptomy mogą występować w
przypadku stresu lub w początkowych stanach przeziębienia/grypy.

Steady State (4)

Twoje tętno od pewnego czasu jest na normalnym poziomie. Efektywny trening wymaga ciężkich
treningów oraz dobrej regeneracji, co z kolei powinno powodować zmiany tętna. Twój OwnOptimizer
wskazuje, że nie ćwiczyłeś dostatecznie ciężko lub nie dostatecznie się zregenerowałeś. Powtórz test po
dniu odpoczynku, ewentualnie lekkiego treningu. Jeżeli odpoczynek okaże się wystarczający, wynik testu
powinien wskazać Good recovery.

Stagnant State (5)

Twoje tętno nadal jest na normalnym poziomie, co trwa już od dłuższego czasu. OwnOptimizer wskazuje,
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że nie ćwiczyłeś na tyle intensywnie, aby optymalnie się rozwijać. W celu poprawienia kondycji
powinieneś włączyć do swojego programu treningowego bardziej intensywne lub dłuższe ćwiczenia.

Hard Training (6)

Twoje tętno, kolejny raz z rzędu, jest wyższe niż zazwyczaj . Być może specjalnie zwiększyłeś
obciążenie treningowe. Wynik wskazuje na przeciążenie, w konsekwencji czego twój organizm wymaga
dobrej regeneracji W celu monitorowania regeneracji; powtórz test po jednym lub dwóch dniach
odpoczynku lub lekkich ćwiczeń.

Overreaching (7)

OwnOptimizer wskazuje, że ćwiczyłeś bardzo intensywnie przez kilka dni lub tygodni. Twoje tętno od
dłuższego czasu pozostaje na wysokim poziomie. Powinieneś, koniecznie, całkowicie się zregenerować.
Im dłuższy był okres intensywnych ćwiczeń, tym dłuższy powinien być okres regeneracji. Po upływie co
najmniej dwóch dni odpoczynku, wykonaj test ponownie .

Sympathetic Overtraining (8)

OwnOptimizer wskazuje, że ćwiczyłeś bardzo intensywnie przez kilka dni lub tygodni a regeneracja
okazała się niewystarczająca. Skutkiem czego organizm jest przetrenowany. W celu ustabilizowania
formy, odpocznij, dokładnie monitorując swój stan. Podczas odpoczynku wykonuj test 2-3 razy w
tygodniu.

Parasympathetic Overtraining (9)

Twoje tętno pozostaje na niskim poziomie; można to interpretować jako stan dobrej regeneracji. Jednak
pozostałe parametry wskazują na przetrenowanie Najprawdopodobniej przez długi okres ciężko
trenowałeś a odpoczynki nie były wystarczające. Sprawdź, czy występują pozostałe objawy
przetrenowania, takie jak ciągłe zmęczenie, zły humor, problemy ze spaniem, przewlekłe bóle mięśni
i/lub uczucie wypalenia. Być może stan ten wynika również z innego typu obciążeń.

Generalizując, zazwyczaj przetrenowanie wywołane jest długim okresem ciężkich ćwiczeń.
Rozwiązaniem tego typu sytuacji jest całkowita regeneracja organizmu. Regeneracja taka może potrwać
kilka tygodni. Nie powinieneś ćwiczyć; wprost przeciwnie, większość okresu regeneracji przeznacz na
odpoczynek. Możesz w tym czasie przeprowadzić kilka bardzo lekkich treningów aerobowych, a tylko
wyjątkowo trening intensywny (krótki).

Możesz też spróbować zmienić rodzaj uprawianego sportu. Nie może jednak się z tym wiązać nadmierny
wysiłek czy przeciążenie. Podczas odpoczynku wykonuj test 2-3 razy w tygodniu. Kiedy poczujesz, że
twój organizm się już zregenerował, w dodatku wynik testu co najmniej raz wskazuje na Normal State lub
Good recovery, możesz pomyśleć o wznowieniu treningów. Jeżeli zdecydujesz się na nowo rozpocząć
cykl treningowy, wyznacz ponownie wartość wyjściową.

Wskazane jest, aby przed radykalną zmianą programu treningowego dokonać analizy wyników testu
OwnOptimizer, nie pomijając przy tym takich aspektów jak samopoczucie czy innych, istotnych z punktu
widzenia treningu, objawów . Jeżeli nie jesteś pewien czy warunki, w jakich przeprowadzony był test, były
optymalne, powtórz go. Na wynik testu mogą mieć wpływ niektóre czynniki zewnętrzne: stres psychiczny,
niedawno przebyta choroba, zmiana otoczenia (temperatura, wysokość) oraz inne. Co najmniej raz w roku, na
początku sezonu, należy na nowo wyznaczyć wartość wyjściową.

OwnOptimizer Trend

Wybierz Test > Optimizer > Trend

W Trend menu możesz obserwować zmiany wartości OwnOptimizer w czasie. Zawiera ono 16 ostatnich
wartości OwnOptimizer wraz z datami ich zapisu. Jeżeli plik się zapełni, najstarszy zapis automatycznie
zostaje zastąpiony przez najnowszy wynik.

Wyświetlony zostanie najnowszy pomiar, wraz z datą, oraz wykres trendu OwnOptimizer. Naciśnij OK
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aby zobaczyć opis wyniku.Przewijaj za pomocą UP lub DOWN aby przejrzeć pozostałe wartości.

Usuń wartości OwnOptimizer.

Wybierz Test > Optimizer > Trend

Wybierz wartość, którą chcesz skasować a następnie naciśnij i przytrzymaj LIGHT. Delete value? No/Yes

zostanie wyświetlone. Potwierdź za pomocą OK.

Reset the Trend File

Wybierz Test > Optimizer > Reset

Możesz wyzerować OwnOptimizer Wszystkie wyniki zostaną usunięte z pamięci. Podczas wykonywania
testu po 365 dniach, lub pierwszy raz po 30 dniach, Reset test period? zostanie wyświetlone.

Analiza rezultatów za pomocą oprogramowania.

Zgranie wyników do programu umożliwia wszechstronną ich analizę oraz dostęp do bardziej
szczegółowych informacji o twoich postępach. Oprogramowanie umożliwia również stworzenie wykresu
porównującego wcześniejsze wyniki.
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10. UŻYWANIE NOWEGO NADAJNIKA

"Uczenie" nowego nadajnika
Jeżeli kupiłeś nowy nadajnik, to nie jest on wprowadzony do odbiornika. Nazywamy to "uczeniem"; trwa
ono zaledwie kilka sekund. "Uczenie" gwarantuje, że odbiornik odbiera sygnał tylko z sensora; pozwala
to bez zakłóceń ćwiczyć w grupie.

Na ekranie głównym wciśnij OK > New WearLink found, Teach new WearLink?

Załóż nadajnik i upewnij się że w odległości 40 m/131 ft nie ma innego nadajnika Polar WearLink
W.I.N.D. Na ekranie głównym naciśnij OK. Odbiornik zaczął szukać sygnału nadajnika.

Gdy dokona jego identyfikacji, New WearLink found, Teach new WearLink? zostanie wyświetlone.
• Wybierz YES aby potwierdzić "nauczenie". Completed! zostanie wyświetlone. Rozpocznij zapis ćwiczenia

poprzez naciśnięcie OK.
• Wybierz NO aby przerwać "uczenie" sensora.

Aby powrócić do ekranu głównego, naciśnij i przytrzymaj STOP.
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11. POZOSTAŁE INFORMACJE

Polar Sport Zones
Za pomocą Polar sport zones można uzyskać wzrost efektywności, prowadzonego w oparciu o tętno,
treningu. Treningi można podzielić na pięć sport zones: stref wyznaczanych jako procent tętna
maksymalnego. Dzięki sport zones możesz w prosty sposób wybrać i monitorować intensywność
treningu.

Strefa docelowa Intensity %
of HRmax,
bpm

Przykładowy
czas trwania

Korzyść treningowa

MAXIMUM

90–100%
171–190 bpm

Poniżej 5
minut

Korzyści: Maksymalny lub bliski
maksymalnego wysiłek dla mięśni i układu

oddechowego.
Reakcja organizmu: Bardzo wyczerpujące dla

mięśni i układu oddechowego.
Zalecane dla: Doświadczonych i

wytrenowanych sportowców. Tylko krótkie
interwały, zazwyczaj w ostatnich

przygotowaniach przed krótkimi zawodami.

HARD

80–90%
152–172 bpm 2–10 minut

Korzyści: Zwiększenie umiejętności znoszenia
intensywnego wysiłku.

Reakcja organizmu: Powoduje zmęczenie
mięśni i ciężki oddech.

Zalecane dla: Doświadczonych sportowców.
W rocznych cyklach treningowych oraz przy

różnej długości ćwiczeniach. Istotne
zwłaszcza podczas przygotowań do sezonu .

MODERATE

70–80%
133–152 bpm 10–40 minut

Korzyści: Poprawa szybkości wykonywania
ćwiczeń, poprawa efektywności, zmniejszenie

wysiłku.
Reakcja organizmu: Spokojny, kontrolowany,

szybki oddech.
Zalecane dla: Sportowców trenujących do

zawodów lub pragnących zwiększyć
wydolność organizmu.

LIGHT

60–70%
114-133 bpm 40–80 minut

Korzyści: ogólne poprawienie kondycji,
przyspieszenie regeneracji, polepszenie

metabolizmu.
Reakcja organizmu: łagodny wysiłek dla

mięśni i serca.
Zalecane dla: Ćwiczenie dla każdego, w

trakcie długich treningów (rozpoczęcie sezonu
treningowego) oraz przy treningach
regeneracyjnych (podczas sezonu).

VERY LIGHT

50–60%
104–114 bpm 20–40 minut

Korzyści: Pomocny w rozgrzewce i
wyciszeniu, wspomaga regenerację.
Reakcja organizmu: Bardzo lekkie,

nieznaczne obciążenie.
Zalecane dla: Lepszej regeneracji jak również
celem wyciszenia organizmu; w trakcie całej

sesji treningowej.
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HRmax = Tętno maksymalne (220-age). Przykład: 30 latek, 220–30=190 bpm.

Ćwiczenie w sport zone 1 przeprowadzane jest na poziomie bardzo lekkiej intensywności. Głównym
celem jest poprawa wydolności w trakcie regeneracji; zarówno podczas treningu jak i po jego
zakończeniu. Przyspiesz proces odnowy poprzez bardzo lekki trening.

Sport zone 2 jest poziomem dla treningów wytrzymałościowych, będących elementem każdego
programu treningowego. Ćwiczenie w tej strefie poprawia gospodarkę tlenową (dotlenia organizm).
Długie treningi w tej strefie charakteryzuje efektywny wydatek energetyczny. Postęp będzie wymagał
wytrwałości.

Wzrost wydolności tlenowej uzyskać można ćwicząc w sport zone 3. Intensywność treningu jest większa
niż w sport zones 1 i 2, lecz nadal ma na celu poprawę wydolności tlenowej. Przykładowo; ćwiczenie w
sport zone 3 może składać się z, poprzedzonych regeneracją, interwałów. Ćwiczenie w tej strefie jest
szczególnie efektywne jeśli chodzi o lepsze ukrwienie serca oraz mięśni.

W sytuacji, gdzie twoim założeniem jest rywalizacja na potencjalnym szczycie, będziesz musiał trenować
w sport zones 4 i 5. W tych strefach ćwiczysz beztlenowo; w interwałach o maksymalnej długości do 10
minut. Im krótszy interwał, tym większa intensywność. Bardzo ważny jest tutaj odpowiedni czas odnowy
pomiędzy interwałami. Szablon treningu w strefach 4 i 5 jest zaprojektowany w taki sposób aby osiągnąć
maksymalne wyniki.

Polar sport zones mogą być personalizowane przez użycie wartości HRmax ; bądź zmierzonej
labolatoryjnie bądź określonej podczas przeprowadzonego przez ciebie testu. Gdy ćwiczysz w sport
zone, postaraj się użyć wszystkich stref. Średnia strefa jest dobrym celem, ale utrzymywanie tętna przez
cały czas na tym samym poziomie nie jest konieczne. Tętno stopniowo dostosowuje się do intensywności
treningu. Na przykład, podczas przechodzenia ze sport zone 1 na 3, system krążenia oraz tętno
dostosują się w 3-5 minut.

Reakcja tętna na intensywność ćwiczenia zależy zarówno od sprawności fizycznej i umiejętności
regeneracji jak i od zewnętrznego otoczenia. Ważne jest, aby zwracać uwagę na swoje samopoczucie,
oznaki zmęczenia i w zależności od nich dobierać program treningowy.

Prostym sposobem na wykorzystanie sport zones jest ćwiczenie w obrębie wyznaczonej strefy tętna. Aby
uzyskać więcej informacji, przejdź doPlanowanie treningu (strona 9).

Po zakończeniu ćwiczenia wyświetlony zostanie czas spędzony w poszczególnych strefach. Wejdź w
ekran Weekly aby zobaczyć jak długo ćwiczyłeś w poszczególnych strefach.

Przy pomocy Polar ProTrainer 5 można ustawić nawet 10 stref; celem ich optymalnego dopasowania do
twoich potrzeb treningowych.

Trening OwnZone
Odbiornik automatycznie ustawia indywidualną i zarazem bezpieczną dla ciebie, pod kątem
intensywności ćwiczeń, strefę: Twoją OwnZone. Polar OwnZone to wyznaczona specjalnie dla ciebie
strefa treningu tlenowego. Funkcja ta przeprowadza cię przez rozgrzewkę, uwzględniając przy tym twój
aktualny stan fizyczny i psychiczny. U większości dorosłych OwnZone odpowiada 65-85% tętna
maksymalnego.

OwnZone można wyznaczyć w ciągu 1-5 minut; w formie rozgrzewki podczas chodu, biegu lub innej
dyscypliny sportowej. Test polega na powolnym rozpoczęciu ćwiczenia, z małą intensywnością, a
następnie stopniowym zwiększaniu tempa. OwnZone jest przeznaczony dla dorosłych, zdrowych osób.
Niektóre czynniki, związane ze stanem zdrowia, mogą uniemożliwić wyznaczenie OwnZone. Należą do
nich wysokie ciśnienie krwi, arytmia serca jak również przyjmowanie niektórych leków.

Istotna, celem utrzymania dobrej kondycji, jest umiejętność oceny i interpretacji zachowań własnego ciała
podczas wysiłku fizycznego.. Używanie funkcji OwnZone przed każdym ćwiczeniem gwarantuje
wyznaczenie najbardziej efektywnej strefy docelowej, odpowiedniej dla tego ćwiczenia.
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Tętno maksymalne
Tętno maksymalne (HRmax) to maksymalna ilość skurczów serca na minutę (bpm) podczas
maksymalnego wysiłku fizycznego. Wielkość ta jest indywidualną i zależną od twojego wieku,
predyspozycji genetycznych oraz poziomu sprawności fizycznej. Może się ono także zmieniać w
zależności od preferowanego sportu. HRmax jest używane do określenia poziomu intensywności
ćwiczenia.

Wyznaczanie maksymalnego tętna

Twoje HRmax może zostać wyznaczone na kilka sposobów.
• Najbardziej dokładnym jest zmierzenie twojego HRmax klinicznie, pod nadzorem kardiologa lub fizjologa

(zazwyczaj jest to bieg na ruchomej bieżni lub test na rowerze).
• Możesz również samodzielnie wyznaczyć swoje HRmax ; podczas ćwiczenia razem z partnerem.
• Inny sposób to wynik HRmax-p który przewiduje twoje HRmax przez przeprowadzenie Polar Fitness Test.
• HRmax może być również wyznaczone przez popularnie znaną formułę: 220 - wiek (chociaż badania

dowodzą, że metoda ta nie jest zbyt dokładna, szczególnie w przypadku osób starszych lub
utrzymujących dobrą formę przez wiele lat).

Jeżeli kilka tygodni temu zakończyłeś ciężki trening i wiesz, że potrafisz bezpiecznie osiągnąć tętno
maksymalne, możesz bez przeszkód, samodzielnie wykonać test wyznaczania HRmax. Wskazane jest,
aby podczas przeprowadzania tego testu, ćwiczyć wraz z innym. Jeżeli masz wątpliwości, przed
wykonaniem testu skonsultuj się z lekarzem .

Oto przykład prostego testu.

Krok 1: 15 minutowa rozgrzewka na płaskiej nawierzchni; dopasuj intensywność do swojego typowego
tempa.

Krok 2: Wybierz wzniesienie, ewentualnie klatkę schodową, gdzie wejście do góry zajmie ci więcej niż 2
minuty. Wbiegnij raz na wzgórze/schody w tempie największym, jakie możesz wytrzymać przez 20 minut.
Wróć na dół wzgórza/schodów.

Krok 3: Wbiegnij ponownie na wzgórze/schody, w tempie jakie możesz utrzymać na odcinku 3
kilometrów. Zanotuj swoje maksymalne tętno. Twoje maksimum jest około 10 uderzeń wyższe niż
wartość, którą zapisałeś.

Krok 4: Zbiegnij ze wzgórza, pozwalając aby tętno spadło o 30-40 uderzeń na minutę

Krok 5: Wbiegnij na wzgórze/schody jeszcze raz w tempie, jakie możesz wytrzymać tylko przez 1
minutę. Spróbuj przebiec połowę drogi na wzgórze/schody. Zanotuj swoje maksymalne tętno. Zbliżyłeś
się do maksymalnego tętna. Użyj tej wartości jako tętno maksymalne w training zones.

Krok 6: Upewnij się, że dobrze odpocząłeś; minimum 10 minut.

Tętno w pozycji siedzącej
HRsit jest to średnie tętno podczas całkowitego braku ruchu (np. podczas siedzenia). Aby wyznaczyć
HRsit ; załóż nadajnik, usiądź i postaraj się nie ruszać. Celem uzyskania bardziej precyzyjego pomiaru,
powtórz procedurę kilka razy i oblicz średnią.

Rezerwa tętna
Rezerwa tętna (HRR) jest to różnica pomiędzy tętnem maksymalnym (HRmax) a tętnem spoczynkowym
(HRrest)*. HRR jest używane do wyliczania tętna ćwiczenia. Jest to zakres w obrębie tętna; zmienia się
on w zależności od poziomu wysiłku. HRR dorównuje absorbcji rezerw tlenu (VO2R).

Tętno odpowiednie do przeprowadzania ćwiczeń można obliczyć za pomocą wzoru Karvonena**. Do
wyrażonej w procentach rezerwy tętna dodaj tętno spoczynkowe.

HR ćwiczenia = % zamierzonej intensywności (HRmax – HRrest) + HRrest
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Przykład:

Założenie; intensywność 70 % HRR dla osoby z HRmax 201 bpm i HRrest 50 bpm

HR ćwiczenia = 70% (201-50) + 50

HR ćwiczenia = 156 bpm

Celem dokładnego określenia HR ćwiczenia, potrzebujesz dokładnych wartości HRmax oraz HRrest. Jeżeli
używasz szacunkowego HRmax, wartość tętna ćwiczenia zawsze będzie szacunkowa.

*W Polarze RS800CX tętno podczas spoczynku określane jest w pozycji siedzącej (HR sit). Jest to
konieczne, z uwagi na dokładność pomiaru (HRsit jest wykorzystywane do obliczenia wydatku
energetycznego). HRsit dopasowuje niską intensywność do ćwiczeń, których intensywność może być
porównana.

**Karvonen M, Kentala K, Mustala O. Efekt treningu pracy serca: długotrwałe badania. Ann Med Exp Biol
Fenn 1957; 35: 307-315.

Zmienność tętna
Każdy skurcz serca jest inny. Zmienność tętna (HRV) jest zmianą długości interwałów pomiędzy dwoma
skurczami serca (interwały R-R).

HRV wskazuje na odchylenia tętna od tętna średniego. Tętno średnie w wartości 60 skurczów na minutę
(bpm) nie oznacza, że odstępy pomiędzy skurczami wynoszą dokładnie 1.0 sek. ponieważ mogą one
trwać od 0.5 sek do 2.0 sek.

Wydolność tlenowa ma wpływ na HRV HRV dla serca w dobrej kondycji jest zazwyczaj niskie w
spoczynku. Inne czynniki, które mają wpływ na HRV to wiek, uwarunkowania genetyczne, pozycja ciała,
pora dnia oraz stan zdrowia. Podczas ćwiczenia, HRV zmniejsza się wraz ze wzrostem intensywności.
HRV zmniejsza się także w stanie stresu.

HRV jest regulowane przez autonomiczny system nerwowy. Aktywność parasympatyczna obniża tętno i
zwiększa HRV, podczas gdy aktywność sympatyczna zwiększa tętno i zmniejsza HRV.

HRV jest stosowane przy funkcjiach Ownzone, OwnIndex oraz OwnOptimizer. Może być ono również
monitorowane za pomocą pulsometru. Jeżeli twoje HRV zmieni się przy podanym tempie i tętnie, może to
oznaczać zmianę w obciążeniu twojego treningu.

Kadencja biegu i długość kroku.
Kadencja* to liczba kroków nogi na której znajduje się stride sensor*, wykonana w ciągu minuty.
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Długość kroku* to średnia długość jednego kroku Jest to odległość między dotknięciem ziemi przez
prawą i lewą nogę.

Prędkość biegu = 2 * długość kroku * kadencja

Prędkość można zwiększać na dwa sposoby: zwiększając kadencję lub długość kroków.

Najlepsi biegacze długodystansowi zwykle biegają z wysoką kadencją 85-95. Na podbiegach, zazwyczaj,
kadencja jest niższa. Wyższa jest natomiast przy zbieganiu. Biegacze długością kroku dyktują prędkość:
im dłuższy krok, tym wyższa prędkość.

Większość początkujących biegaczy robi jednak za duże kroki. Najbardziej efektywną długością kroku
jest długość naturalna - przy której najlepiej się czujesz. Zwiększenie prędkości uzyskasz poprzez
wzmocnienie mięśni nóg; zwiększając siłę nośną, w rezultacie wydłużysz krok.

Powinieneś także popracować nad maksymalną efektywnością kadencji. Nie ma możliwości szybkiej
zmiany kadencji, jednak przy odpowiednim treningu da się to zrobić i tym samym polepszyć swoje wyniki.
Celem optymalizacji kadencji, należy regularnie trenować połączenia nerwowo-mięśniowe. Zacznij od
jednego ćwiczenia tygodniowo na kadencję. Pozostałe ćwiczenia również mogą posiadać elementy
treningu kadencji. Podczas długich, lekkich biegów od czasu do czasu możesz zwiększać kadencję.

Monitorowanie kadencji jest przydatne w sytuacji, gdy przygotowujesz się do długodystansowych
zawodów (½ Maraton, Maraton lub dłuższe). Niska kadencja, przy założonym rytmie biegu, może, z
powodu zmęczenia nóg, osłabić twój finisz. Jedynym sposobem rozwiązania tego problemu jest
zwiększenie kadencji przy stałym tempie. Możesz ustawić swojego Polara tak, aby pokazywał tempo i
kadencję. Próbuj skrócić krok i zwiększyć kadencję, utrzymując ten sam rytm biegu (ustaw wąską strefę
rytmu i alarm dźwiękowy). Możesz starać się zwiększyć kadencję powyżej następujacych:
• 80/min (maratończycy 4 h)
• 85/min (maratończycy 3:30 h)
• 88/min (maratończycy 3h)

Wartości te są jedynie orientacyjne; wysocy biegacze będą mieli niższą kadencję. Biegający powinni
także zwracać uwagę na swoje subiektywne odczucia.

Podbieganie pagórków, bieg po piasku, bieganie po schodach; to przykłady specyficznych ćwiczeń
siłowych na zwiększenie długości kroku. Sześciotygodniowy okres treningu, zawierający ćwiczenia
siłowe, powinien skutkować widoczną poprawą długości kroku. Jeżeli dorzuci się do tego ćwiczenia
kadencji (np. krótkie kroki w najlepszym 5-cio km tempie), widoczna poprawa powinna być zauważona
również w prędkości biegu.

*opcjonalny s3 stride sensor W.I.N.D. jest wymagany.

Zapis R-R
Zapis R-R pozwala na zapisanie odległości pomiędzy dwoma skurczami serca. Informacja ta jest
wyświetlana również jako tętno wyrażone w skurczach serca na minutę.

Przy takim zapisie możliwe jest zauważenie każdego, dodatkowego skurczu serca. Celem optymalnego
kontaktu nadajnika ze skórą zaleca się użycie specjalnego żelu (żel ECG). Błędny odczyt tętna można
skorygować za pomocą oprogramowania.

Polar Running Index
Running Index to prosty sposób monitorowania swoich wyników. Wydajność (jak szybko/łatwo możesz
biec w określonym tempie) jest czynnikiem mającym bezpośredni wpływ na wydolność tlenową (VO 2max)
oraz ekonomię ćwiczeń (jak efektywne jest twoje ciało podczas biegu); Running Index jest pomiarem
tego oddziaływania. Poprzez zapis swojego Running Indexu możesz monitorować czynione postępy.
Poprawa oznacza, że bieganie w danym tempie wymaga mniej wysiłku, lub, że twoje tempo jest szybsze
na danym poziomie wysiłku. Running Index oblicza właśnie taki rozwój in plus. Running Index dostarcza
ci również codziennie informacji o poziomie wydajności biegu, który może się zmieniać z dnia na dzień.
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Korzyści wynikające z Running Indexu:
• pokazuje pozytywne efekty dobrze prowadzonych ćwiczeń i odpoczynków.
• monitoruje rozwój twojej formy na różnych poziomach intensywności treningu (nie tylko podczas

maksymalnego wysiłku).
• możesz określić optymalną dla siebie prędkość biegu porównując Running Index z różnych ćwiczeń.
• umożliwia rozwój formy poprzez dobór optymalnej techniki i intensywności biegu.

Running Index jest obliczany podczas każdego ćwiczenia, w którym tętno i sygnał s3 stride/G3 GPS
sensora* zostały zapisane, oraz gdy zostały spełnione następujące wymagania :
• minimalna prędkość biegu wynosi 6km/h / 3,75 mi/h a czas trwania ćwiczenia przekracza 12 minut.
• Tętno powinno być powyżej 40% HRmax.

Sprawdź czy skalibrowałeś Foot pod Obliczanie Running Indexu rozpoczyna się w momencie włączenia
zapisu ćwiczenia. Podczas ćwiczenia możesz się raz zatrzymać (np. na światłach), nie powodując
przerwy w kalkulacji.

Po zakończeniu ćwiczenia, odbiornik wyświetli wartość Running Indexu i przechowa rezultaty w sekcji
plików. Znajdź swój wynik w poniższej tabeli. Z pomocą oprogramowania możesz monitorować i
analizować Running Index pod kątem czasu i różnych prędkości. Możesz też porównać wyniki Running
Index z różnego rodzaju ćwiczeń i przeprowadzić krótko- i długookresową analizę.

Krótkoterminowa analiza

Mężczyźni

Wiek/liczba
lat

B. niski Niski Dostateczny Średni Dobry B. dobry Elita

20-24 < 32 32-37 38-43 44-50 51-56 57-62 > 62

25-29 < 31 31-35 36-42 43-48 49-53 54-59 > 59

30-34 < 29 29-34 35-40 41-45 46-51 52-56 > 56

35-39 < 28 28-32 33-38 39-43 44-48 49-54 > 54

40-44 < 26 26-31 32-35 36-41 42-46 47-51 > 51

45-49 < 25 25-29 30-34 35-39 40-43 44-48 > 48

50-54 < 24 24-27 28-32 33-36 37-41 42-46 > 46

55-59 < 22 22-26 27-30 31-34 35-39 40-43 > 43

60-65 < 21 21-24 25-28 29-32 33-36 37-40 > 40

Kobiety

Wiek/liczba
lat

B. niski Niski Dostateczny Średni Dobry B. dobry Elita

20-24 < 27 27-31 32-36 37-41 42-46 47-51 > 51

25-29 < 26 26-30 31-35 36-40 41-44 45-49 > 49

30-34 < 25 25-29 30-33 34-37 38-42 43-46 > 46

35-39 < 24 24-27 28-31 32-35 36-40 41-44 > 44

40-44 < 22 22-25 26-29 30-33 34-37 38-41 > 41

45-49 < 21 21-23 24-27 28-31 32-35 36-38 > 38
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Wiek/liczba
lat

B. niski Niski Dostateczny Średni Dobry B. dobry Elita

50-54 < 19 19-22 23-25 26-29 30-32 33-36 > 36

55-59 < 18 18-20 21-23 24-27 28-30 31-33 > 33

60-65 < 16 16-18 19-21 22-24 25-27 28-30 > 30

Klasyfikacja ta opiera się na przeglądzie 62 prac, w ramach których wskaźnik VO2max zmierzono
w sposób bezpośredni zdrowym dorosłym mieszkańcom USA, Kanady i 7 krajów europejskich. Źródło:
Shvartz E., Reibold R.C. Aerobic fitness norms for males and females aged 6 to 75 years: a review.
(Normy wydolności aerobowej mężczyzn i kobiet w wieku od 6 do 75 lat: przegląd. Aviat Space Environ
Med; 61:3-11, 1990.

Wartość Running Indexu może się zmieniać z dnia na dzień, z uwagi na warunki przeprowadzenia
treningu np. ukształtowanie terenu, rodzaj podłoża, wiatr, temperatura.

Długoterminowa analiza

Wartości Running Indexu w czasie tworzą wykres, który ocenia twoją zdolność biegania określonych
dystansów.

Poniższa tabela szacuje czas potrzebny do przebiegnięcia określonego dystansu, przy maksymalnym
wysiłku. Użyj swojej długookresowej średniej Running Indexu; znajdź ją w tabeli. Przewidywanie jest
najlepsze dla tych wartości Running Indexu, które zostały otrzymane, przy prędkości i biegu, w
okolicznościach zbliżonych do wyznaczonej wydajności.

Running
Index

Test Coopera
(m)

5 km (g:mm:ss) 10 km (g:mm:ss) 21,098 km
(g:mm:ss)

42,195 km
(g:mm:ss)

36 1800 0:36:20 1:15:10 2:48:00 5:43:00

38 1900 0:34:20 1:10:50 2:38:00 5:24:00

40 2000 0:32:20 1:07:00 2:29:30 5:06:00

42 2100 0:30:40 1:03:30 2:21:30 4:51:00

44 2200 0:29:10 1:00:20 2:14:30 4:37:00

46 2300 0:27:50 0:57:30 2:08:00 4:24:00

48 2400 0:26:30 0:55:00 2:02:00 4:12:00

50 2500 0:25:20 0:52:40 1:57:00 4:02:00

52 2600 0:24:20 0:50:30 1:52:00 3:52:00

54 2700 0:23:20 0:48:30 1:47:30 3:43:00

56 2800 0:22:30 0:46:40 1:43:30 3:35:00

58 2900 0:21:40 0:45:00 1:39:30 3:27:00

60 3000 0:20:50 0:43:20 1:36:00 3:20:00

62 3100 0:20:10 0:41:50 1:32:30 3:13:00

64 3200 0:19:30 0:40:30 1:29:30 3:07:00

66 3300 0:18:50 0:39:10 1:26:30 3:01:00
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Running
Index

Test Coopera
(m)

5 km (g:mm:ss) 10 km (g:mm:ss) 21,098 km
(g:mm:ss)

42,195 km
(g:mm:ss)

68 3350 0:18:20 0:38:00 1:24:00 2:55:00

70 3450 0:17:50 0:36:50 1:21:30 2:50:00

72 3550 0:17:10 0:35:50 1:19:00 2:45:00

74 3650 0:16:40 0:34:50 1:17:00 2:40:00

76 3750 0:16:20 0:33:50 1:14:30 2:36:00

78 3850 0:15:50 0:33:00 1:12:30 2:32:00

*Opcjonalny s3 stride sensor lub G3 GPS sensor W.I.N.D. jest wymagany.

Do osiągnięcia maksymalnych wyników, oprócz Running Indexu istotne są również dobre przygotowanie,
dobre warunki do biegania i nastawienie psychiczne. Ważna jest przy tym jakość i ilość treningów oraz
wrodzone predyspozycje.

Polar Training Articles
W celu znalezienia dodatkowych informacji na temat biegania odwiedź Polar Article Library
[http://articles.polar.fi] .
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12. INFORMACJE SERWISOWE DLA KLIENTA

Konserwacja i przechowywanie

Dbanie o produkt
Obchodź się z Polarem ostrożnie (jest to urządzenie elektroniczne). Stosowanie się do poniższych
wskazówek umożliwi nie tylko zachowanie gwarancji ale i bezawaryjne działanie Polara przez wiele lat.

Po każdym treningu odczep nadajnik od elektrod; elektrody umyj pod bieżącą wodą . Wysusz
nadajnik za pomocą miękkiego ręcznika . Nigdy nie używaj alkoholu ani substancji żrących (środki
chemiczne).

Pierz elektrody regularnie (minimum co pięć treningów) w pralce w temperaturze 40ºC/104ºF .
Prawidłowa konserwacja zapewni wiarygodny pomiar oraz zwiększy żywotność elektrod. Pierz elektrody,
wkładając je do płóciennego worka lub poszewki. Nie przemocz, nie wiruj, nie prasuj oraz nie wybielaj
elektrod. Nie używaj detergentów z wybielaczem lub środkiem zmiękczającym . Nigdy nie wkładaj
nadajnika do pralki lub suszarki !

Elektrody oraz nadajnik susz i przechowuj osobno. Wypierz elektrody zarówno w przypadku ich
dłuższego przechowywania jak również w przypadku, gdy używałeś Polara na basenie (woda o dużym
stężeniu chloru).

Odbiornik i nadajnik przechowuj w suchym i chłodnym miejscu . Przechowuj Polara w suchym i
przewiewnym miejscu;nie trzymaj go w plastikowej torbie czy mokrym ręczniku. Nie narażaj Polara na
długotrwałe działanie promieni słonecznych.

Zakres temperatur, w jakich bezpiecznie możesz używać Polara: -10 °C do +50 °C / +14 °F to +122 °F.

Serwis
Podczas obowiązywania 2-letniej gwarancji wszystkie usługi serwisowe wykonywane być mogą jedynie w
autoryzowanym Centrum Serwisowym Polara. Gwarancja nie obejmuje zniszczeń powstałych w trakcie
lub w wyniku wykonywania napraw przez osoby do tego nieupoważnione. Celem uzyskania dalszych
informacji, przejdź do Międzynarodowa Gwarancja Polara (strona 66).

Wymiana baterii
Dokonuj wymiany baterii w autoryzowanym Centrum Serwisowym Polara Unikaj otwierania obudowy

Aby samemu dokonać wymiany baterii w odbiorniku/nadajniku, postępuj według instrukcji w Changing
Training Computer Battery.

Aby uniknąć utraty danych, przed zmianą baterii przenieś wszystkie dane do programu Polar Prorainer 5.
Więcej informacji znajdziesz w pliku pomocy Polar ProTrainer 5.

Jeżeli chciałbyś aby wymiany dokonał Polar, skontaktuj się z autoryzowanym centrum serwisowym.

Changing Training Computer Battery
Aby zmienić baterię w odbiorniku, potrzebna będzie moneta oraz bateria (CR 2032).

1. Używając monety, otwórz kapsel baterii przekręcając go w kierunku odwrotnym do wskazówek zegara

2. Zdejmij kapsel baterii. Bateria jest przymocowana do kapsla; ostrożnie ją unieś. Usuń baterię/zastąp ją
nową. Bądź ostrożny; nie uszkodź kapsla lub tyłu obudowy .

3. Umieść baterię plusem (+) w stronę kapsla/minusem (-) w stronę odbiornika.

4. Do przykrywki przymocowana jest również uszczelka kapsla . Zmień uszczelkę, jeżeli jest uszkodzona.
Przed zamknięciem kapsla, upewnij się, że uszczelka nie jest uszkodzona i że poprawnie umieściłeś ją
w rowku .

5. Włóż kapsel na swoje miejsce; zamknij za pomocą monety, przekręcając go zgodnie z ruchem
wskazówek zegara, do pozycji CLOSE. Upewnij się, że kapsel został właściwie założony!
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Nadmierne używanie podświetlenia przyspieszy wyczerpanie baterii. Wskaźnik zużycia baterii może
pojawić się także przy używaniu Polara w niskich temperaturach; zniknie, gdy temperatura otoczenia
wzrośnie. Pokrywę baterii otwieraj jedynie w celu wymiany baterii. W trakcie wymiany baterii sprawdź czy
nie jest zniszczona uszczelka. Jeśli tak, należy ją wymienić. Baterie i uszczelki możesz kupić w dobrze
zaopatrzonych sklepach Polara jak również w autoryzowanym serwisie. W USA i Kanadzie uszczelki są
dostępne wyłącznie w autoryzowanych Centrach Serwisowych Polara..

Trzymaj baterie z daleka od dzieci. W przypadku połknięcia baterii przez dziecko, niezwłocznie skontaktuj się z
lekarzem. Zgodnie z obowiązującym prawem, zużyte baterie wyrzucaj do odpowiednich pojemników.

Uwagi

Zakłócenia podczas ćwiczeń
Zakłócenia elektromagnetyczne i sprzęt sportowy

Zakłócenia mogą występować w pobliżu źródeł wysokiego napięcia lub w otoczeniu komputerów.
Zakłócenia w pracy RS800CX mogą powodować również stacje WLAN. Aby wyeliminować przerwy w
odczytach lub nieprawidłowe wskazania, unikaj zbliżania się do potencjalnych źródeł zakłóceń.

Zakłócenia mogą powodować również niektóre części elektronicznego sprzętu sportowego np.
wyświetlacze LED, silniki czy hamulce elektromagnetyczne. W celu rozwiązania tego problemu, spróbuj:

1. Zdejmij nadajnik z klatki piersiowej i rozpocznij ćwiczenie na powodującym zakłócenia sprzęcie.
2. Obracaj odbiornik dopóki nie ustalisz miejsca, w którym zanika sygnał i/lub nie miga symbol serca.

Zazwyczaj największe zakłócenia pojawiają się centralnie, przed wyświetlaczem wyposażenia, podczas
gdy lewa oraz prawa strona są od nich wolne.

3. Załóż ponownie nadajnik na klatkę piersiową; w miarę możliwości trzymaj odbiornik w miejscu wolnym
od zakłóceń.

Jeżeli odbiornik nadal nie działa, przypuszczalnie część wyposażenia sportowego może być elektrycznie
zbyt głośna dla bezprzewodowego pomiaru rytmu serca.

Używanie RS800 w środowisku wodnym

Polar jest wodoszczelny. Jednakże nie jest możliwym dokonanie pomiaru pulsu w wodzie. Możesz
używać odbiornika pod wodą jako zegarka, lecz nie będzie on mierzyć tętna. Aby utrzymać
wodoszczelność NIE naciskaj przycisków pod wodą. Używanie pulsometru podczas dużych opadów
deszczu również może spowodować zakłócenia w jego pracy.

POLSKI

62 INFORMACJE SERWISOWE DLA KLIENTA



Minimalizacja ryzyka podczas ćwiczenia
W przypadku niektórych osób, z uwagi na ich stan zdrowia, trening może być obciążony pewnym
stopniem ryzyka Zanim zaczniesz regularne ćwiczenia odpowiedz na poniższe, dotyczące twojego stanu
zdrowia, pytania. Jeżeli odpowiesz TAK na jakiekolwiek z tych pytań, przed rozpoczęciem ćwiczeń
skonsultuj się z lekarzem.
• Czy w ciągu ostatnich 5 lat nie byłeś aktywny fizycznie?
• Czy masz wysokie ciśnienie krwi lub wysoki poziom cholesterolu?
• Czy zażywasz jakiekolwiek leki na ciśnienie krwi lub na serce?
• Czy masz lub miałeś problemy z oddychaniem?
• Czy masz objawy jakiejkolwiek choroby?
• Czy jesteś w trakcie rehabilitacji po przebytej chorobie lub po operacji?
• Czy używasz rozrusznika serca lub innego, wszczepionego urządzenia elektronicznego?
• Czy palisz papierosy?
• Czy jesteś w ciąży?

Wysiłek fizyczny nie jest jedynym czynnikiem wpływającym na tętno. Wybierając stopień intensywności
treningu, weź pod uwagę że: leki, ciśnienie krwi, kondycja psychiczna, astma, wydolność oddechowa
etc.jak również napoje energetyzujące, alkohol oraz nikotyna mają wpływ na pracę serca.

Istotnym jest zwracanie uwagi na reakcje organizmu podczas treningu. Jeżeli poczujesz
niespodziewany ból lub też czujesz duże zmęczenie podczas ćwiczenia, zaprzestań treningu lub
zmniejsz jego intensywność

Informacje dla osób z rozrusznikami serca, defibrylatorami lub innymi wszczepionymi
urządzeniami elektronicznymi. Osoby posiadające rozrusznik serca używają Polara na własne ryzyko.
Przed rozpoczęciem użytkowania, zaleca się wykonanie ćwiczenia (z maksymalnym obciążeniem) pod
nadzorem lekarza. Test jest przeprowadzany aby zapewnić bezpieczeństwo, jak również niezawodność
równocześnie używanych: rozrusznika serca i Polara.

Jeżeli jesteś uczulony na materiały, które mają kontakt ze skórą i obawiasz się reakcji
uczuleniowej podczas używania produktu, sprawdź w Specyfikacji Technicznej listę materiałów, z
jakich jest on wykonany. Aby uniknąć reakcji alergicznej na elektrody, zakładaj je na koszulkę. Aby
zapewnić optymalne działanie elektrod, zmocz dokładnie koszulkę w miejscu ich założenia.

Twoje bezpieczeństwo jest dla nas bardzo ważne. Kształt s3 stride sensora* został tak zaprojektowany
aby zminimalizować ryzyko zaczepienia nim o coś. Na wszelki wypadek, bądź ostrożny biegając np. w
lesie.

Pod wpływem potu nadajnik może zafarbować jasne ubrania na czarno. Jeżeli stosujesz zewnętrznie preparaty
do odstraszania owadów (np. anty-komarowe czy inne) upewnij się, że nie wejdą one w reakcję z nadajnikiem.

*opcjonalny s3 stride sensor W.I.N.D. jest wymagany.

Specyfikacja techniczna

Odbiornik

Laser Product 1 klasy
Żywotność baterii: Średnio 1 rok (1h/dzień, 7 dni w tygodniu)
Typ baterii: CR2032
Uszczelka baterii: O-Ring 20.0 x 1.1, material silicone
Temperatura, w jakiej działa Polar: -10 °C do +50 °C / 14 °F do 122 °F
Pasek i sprzączka: Poliuretan, stal nierdzewna
Denko: Poliamid, stal nierdzewna, zgodna z normą EU Directive 94/27/EU oraz poprawką1999/C

205/05, dotyczącą zawartości niklu w produkcie, który ma bezpośredni kontakt ze skórą.
Dokładność zegarka: Lepsza niż ± 0,5 sekundy / dzień przy temperaturze 25 °C / 77 °F.
Dokładność monitora pracy serca: ± 1% lub 1 bpm, . Przy założeniu stabilnych warunków.
Zakres pomiaru tętna: 15-240
Zakres pomiaru prędkości: Stride sensor: 0-36 km/h or 0-22,3 mph, cadence 0-255 rpm

G3 GPS sensor: 0-250 km/h or 0-155,3 mph
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Speed sensor: 0-127 km/h or 0-78,9 mph
Cadence sensor: 15-200 rpm

Zakres pomiaru wysokości: -550 m … +9000 m / -1800 ft … +29500 ft
Odbiornik oblicza wysokość na podstawie średniej wysokości przy zdefiniowanym
ciśnieniu, zgodnie z ISO 2533.

Wzniesienie i spadek terenu: 5 m / 20 ft

Wartości limitów odbiornika
Maksymalna ilość plików: 99
Maksymalny czas pliku: 99 h 59 min 59 s
Maksymalne okrążenia (manual): 99
Maksymalne okrążenia (automatic): 99
Buty 1/2/3 ogólny dystans: 999 999 km / 621370 mi
Rower 1/2/3 ogólny dystans: 999 999 km / 621370 mi
Ogólny dystans buta / GPS / roweru 999 999 km / 621370 mi
Całkowity dystans: 999 999 km / 621370 mi
Całkowity czas trwania: 9999h 59min 59s
Całkowita ilość kalorii: 999 999 kcal
Całkowita ilość ćwiczeń: 9999
Całkowita suma podejść: 304795 m / 999980 ft
Suma odometru: 999 999 km / 621370 mi

Nadajnik

Żywotność baterii nadajnika WearLink
W.I.N.D.:

Średnio 2 lata (1h/dzień, 7 dni w tygodniu)

Typ baterii: CR2025
Uszczelka baterii: O-Ring 20.0 x 1.0, material silicone
Temperatura, w jakiej działa nadajnik: -10 °C do +40 °C / 14 °F do 104 °F
Materiał łącznika: Poliamid
Materiał paska: Poliuretan/ Poliamid/ Poliester/ Elastan/ Nylon

Polar ProTrainer 5™

Wymagania systemowe: PC
Windows® 2000/XP (32bit), Vista
Port na podczerwień IrDA (urządzenie zewnętrzne IrDA lub wbudowany
port IR)
Dodatkowo, poza oprogramowaniem, twój PC musi posiadać procesor
Pentium II 200 MHz (lub szybszy), monitor SVGA (lub lepszy), 50 MB
wolnej pamięci i stację dysków CD-ROM.

Polar WebLink używa komunikacji IrDA

Wymagania systemowe: PC
Windows® 98/98SE/ME/2000/XP
Port na podczerwień IrDA (urządzenie zewnętrzne IrDA lub wbudowany
port IR)

Polar sygnalizuje poziom wysiłku/obciążenia fizjologicznego oraz intensywność ćwiczeń. Wyświetla wskaźnik rezultatów
oraz warunki meteorologiczne takie jak temperatura i wysokość. Mierzy również prędkość i dystans (podczas używania
s3 stride sensora/sensora prędkości roweru/G3 GPS sensora), kadencję biegu (podczas używania s3 stride sensora),
kadencję rowerową (przy sensorze kadencji) oraz dostarcza danych na temat położenia (za pomocą G3 GPS sensora).
Użycie Polara w innych celach nie jest wskazane.

Polar nie powinien być używany do przeprowadzania pomiarów środowiska, wymagających profesjonalnych narzędzi
oraz precyzji. Urządzenie to nie powinno być także używane do wykonywania pomiarów pod wodą i w powietrzu.

Wodoszczelność Polara jest testowana zgodnie z międzynarodowymi wymogami ISO 2281. Produkty,
pod względem szczelności, zostały podzielone na trzy kategorie. Kategorię wodoszczelności produktu
można znaleźć na jego odwrocie a jej znaczenie odczytać z poniższej tabeli. Poniższe określenia nie
muszą być zgodne z definicjami podawanymi przez innych producentów.

Oznaczenie na odwrocie Charakterystyka wodoszczelności
Wodoszczelność Odporne na: ochlapanie, pot, krople deszczu. Nie używać

podczas pływania
Wodoszczelność 30 m/50 m Można stosować podczas pływania oraz kąpieli
Wodoszczelność 100 m Można stosować podczas pływania i nurkowania z ABC

(bez butli)
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*Charakterystyka ta dotyczy również nadajnika Polar WearLink W.I.N.D. (wodoszczelność na poziomie
30m).

Najczęściej Zgłaszane Pytania
Co powinienem zrobić, gdy...

...symbol baterii i komunikat Battery low zostaną wyświetlone?

Pierwszym znakiem wyczerpania baterii jest zazwyczaj wskaźnik zużycia baterii. Wskaźnik ten może się
również pojawić w warunkach niskiej temperatury. Zniknie, gdy temperatura otoczenia wróci do normy.
Gdy pojawi się symbol wyczerpania baterii, dźwięki i podświetlenie zostaną automatycznie wyłączone.
Aby uzyskać więcej informacji na temat zmiany baterii, przejdź do Konserwacja i przechowywanie
(strona 61).

...Nie wiem, w którym miejscu w menu się znajduję?

Wciśnij i przytrzymaj STOP do momentu aż powrócisz do ekranu głównego.

...przyciski nie reagują?

Zresetuj odbiornik poprzez jednoczesne naciśnięcie i przytrzymanie przez 2 sekundy wszystkich
bocznych przycisków; ekran powinien zapełnić się pikselami. Po resecie naciśnij jakikolwiek przycisk i
wprowadź godzinę oraz datę. Wszystkie inne ustawienia zostały zachowane. Pomiń resztę ustawień
przez wciśnięcie i przytrzymanie STOP.

...odczyt tętna staje się nieregularny, bardzo wysoki lub wskazuje zero (00)?
• Sprawdź, czy nadajnik nie poluzował się podczas ćwiczenia.
• Sprawdź, czy elektrody w ubraniu sportowym są poprawnie ułożone.
• Sprawdź, czy elektrody są dostatecznie wilgotne.
• Sprawdź, czy nadajnik/ubranie sportowe są czyste.
• Przyczyną zakłóceń w pracy nadajnika może być silne pole elektromagnetyczne. Celem uzyskania

dalszych informacji, przejdź do Uwagi (strona 62).
• Jeżeli, pomimo oddalenia się od źródeł możliwych zakłóceń, złe wskazanie tętna nie ulegnie zmianie,

zwolnij i sprawdź tętno manualnie. Jeżeli twoje samopoczucie odpowiada wysokim wskazaniom w
odbiorniku, może mieć to związek z arytmią serca. Pomimo, iż większość przypadków arytmii nie jest
groźna, powinieneś skontaktować się z lekarzem

• Jakiś czynnik mógł zmienić siłę twoich fal ECG. W takim przypadku skonsultuj się z lekarzem.

…Memory full jest wyświetlone?

Wiadomość taka pojawia się jeśli podczas ćwiczenia zapisałeś 99 okrążeń lub nie ma już wolnego
miejsca w pamięci. W tym przypadku przestań zapisywać ćwiczenie i przenieś dane z odbiornika do
programu Polar ProTrainer 5. Następnie wykasuj przeniesione dane z odbiornika.

…Check WearLink! zostanie wyświetlone i odbiornik nie może znaleść sygnału tętna?
• Sprawdź, czy nadajnik nie poluzował się podczas ćwiczenia.
• Sprawdź, czy elektrody w ubraniu sportowym są poprawnie ułożone.
• Sprawdź, czy elektrody są dostatecznie wilgotne.
• Sprawdź, czy nadajnik/ubranie sportowe są czyste i nie są zniszczone.
• Jeżeli brak pomiaru występuje podczas ćwiczenia w stroju sportowym (z wszytymi przez producenta

elektrodami), spróbuj użyć elektrod z Wear Linka. Jeżeli przyniesie to efekt, problem najprawdopodobniej
dotyczy wspomnianego stroju sportowego. Skontaktuj się z jego sprzedawcą/producentem.

• Jeżeli wykonałeś wszystkie wyżej wspomniane czynności, a komunikat nadal się pojawia oraz nie ma
sygnału pulsu, przypuszczalnie bateria w nadajniku jest wyczerpana. Celem uzyskania dalszych
informacji, przejdź do Konserwacja i przechowywanie (strona 61).

…New WearLink found. Teach new WearLink? zostanie wyświetlone.
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Jeżeli kupiłeś nowy nadajnik, musi być on "nauczony" odbiornika. Celem uzyskania dalszych informacji,
przejdź do "Uczenie" nowego nadajnika (strona).

W przypadku jeśli kupiłeś odbiornik z nadajnikiem w komplecie i komunikat ten pojawia się na ekranie
odbiornika, prawdopodobnie odbiera on sygnał z innego nadajnika. W takim przypadku upewnij się, że
nadajnik, który masz na sobie, jest twój oraz sprawdź, czy elektrody są dobrze zwilżone a nadajnik nie
poluzował się. Jeżeli komunikat nadal się pojawia, oznacza to, że bateria w nadajniku jest wyczerpana.
Celem uzyskania dalszych informacji, przejdź do Konserwacja i przechowywanie (strona 61).

...S sensor calibration failed jest wyświetlone?*

Kalibracja nie powiodła się i musisz ją przeprowadzić ponownie. Kalibracja kończy się niepowodzeniem
jeśli poruszysz się w momencie gdy odbiornik dokonuje obliczeń. Po przebiegnięciu zamierzonego
dystansu zatrzymaj się i nie ruszaj, aby odbiornik mógł dokonać obliczeń. Podczas ręcznej kalibracji
można wprowadzić współczynnik w zakresie 0.500-1.500. Jeżeli wprowadzisz niższą lub wyższą wartość
kalibracja kończy się niepowodzeniem.

…Teach new sensor? zostanie wyświetlone.

Jeżeli kupiłeś nowy sensor, musi być on "nauczony" odbiornika. Celem uzyskania dalszych informacji,
przejdź do Ustawienia funkcji (strona 33).

W przypadku jeśli kupiłeś odbiornik z sensorem w komplecie i komunikat ten pojawia się na ekranie
odbiornika, prawdopodobnie odbiera on sygnał z innego sensora. W takim przypadku upewnij się że
używasz swojego sensora. Jeżeli komunikat nadal się pojawia, oznacza to, że bateria w senorze jest
wyczerpana. Celem uzyskania dalszych informacji, przejdź do Konserwacja i przechowywanie
(strona 61).

...wysokość zmienia się, pomimo że się nie ruszam?

Odbiornik przelicza ciśnienie powietrza na odczyt wysokości. Z tego powodu zmiana pogody może
spowodować zmianę wysokości.

…odczyty wysokości są niedokładne?

Wysokościomierz może wskazywać złą wysokość pod wpływem warunków zewnętrznych takich jak silny
wiatr lub klimatyzacja. W takim przypadku spróbuj skalibrować wysokościomierz. Jeżeli wskazania są
błędne przez cały czas, być może kanaliki pomiaru ciśnienia zostały zablokowane (przez kurz lub np.
błoto). W tym przypadku wyślij odbiornik do Autoryzowanego Serwisu Polara.

....Memory low jest wyświetlone?

Memory low jest wyświetlane w sytuacji, gdy pozostało około 1 godziny wolnej pamięci. Aby
zmaksymalizować pozostałą pojemność pamięci, ustaw najdłuższy czas uśredniania (60 sec) w Settings

> Features > Rec.rate . Gdy pamięć zostanie zapełniona, wyświetli się komunikat Memory full . Aby
zwolnić pamięć, przenieś ćwiczenie z odbiornika do programu Polar Pro Trainer 5, a następnie usuń je z
Polara.

*opcjonalny s3 stride sensor W.I.N.D. jest wymagany.

Międzynarodowa Gwarancja Polara
• Gwarancja międzynarodowa wydawana jest przez Polar Electro Inc. dla klientów, którzy kupili ten produkt

w USA lub Kanadzie. Gwarancja międzynarodowa wydawana jest przez Polar Electro Inc. dla klientów,
którzy kupili ten produkt w innych krajach.

• Polar Electro Oy/Polar Electro Inc. gwarantuje pierwszemu nabywcy tego urządzenia, że produkt będzie
wolny od wad materiałowych i produkcyjnych przez okres dwóch lat od daty zakupu. .

• Zatrzymaj kartę gwarancyjną oraz dowód zakupu, Serwis będzie ich wymagać podczas napraw
gwarancyjnych!

• Gwarancja nie obejmuje baterii, pęknięć/złamań obudów i pasków, zniszczeń spowodowanych
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niewłaściwym użytkowaniem/nie przestrzeganiem uwag zawartych w instrukcji, wypadkami, używaniem
produktu do celów komercyjnych.

• Gwarancja nie obejmuje także zniszczeń/strat, kosztów/wydatków, (bezpośrednich, pośrednich czy
przypadkowych), związanych z użytkowaniem produktu. W okresie gwarancyjnym produkt zostanie
naprawiony (lub wymieniony, według decyzji dystrybutora) bez opłaty w autoryzowanym serwisie.

• Gwarancja ta nie wpływa na, wynikające z umowy sprzedaży, ustawowe prawa konsumenta względem
sprzedawcy.

Produkt ten jest zgodny z wymogami dyrektywy 93/42/EEC oraz 1999/5/EC. Homologacja dostępna jest
pod następującym adresem www.support.polar.fi/declaration_of_conformity.html.

Produkt jest urządzeniem elektronicznym objętym dyrektywą 2012/19/UE Parlamentu i Rady Europejskiej
dotyczącą odpadów elektrycznych i elektronicznych (WEEE). W związku z powyższym produkt ten
powinien, po jego zużyciu, trafić do odpowiednich pojemników na śmieci (normy UE). Firma Polar
zachęca użytkowników do, zgodnej z prawem lokalnym, segregacji odpadów elektronicznych także poza
granicami UE. W ten sposób wnosisz wkład w minimalizację wpływu śmieci na środowisko naturalne i
ludzkie życie.

Prawa autorskie © 2013 Polar Electro Oy, FIN-90440 KEMPELE, Finland.

Polar Electro Oy posiada certyfikaty ISO 9001:2000.

Wszystkie prawa zastrzeżone. Zarówno instrukcja ta, jak i poszczególne jej fragmenty nie mogą być w
żadnej formie rozprzestrzeniane i kopiowane bez pisemnej zgody Polar Electro Oy. Nazwy i logo
oznaczone symbolem ™ w tej instrukcji obsługi i/lub na opakowaniu tego produktu są znakami
towarowymi Polar Electro Oy. Nazwy i loga oznaczone symbolem ® w tej instrukcji obsługi i/lub na
opakowaniu tego produktu są zastrzeżonymi znakami towarowymi Polar Electro Oy, za wyjątkiem
Windows, który jest zastrzeżonym znakiem towarowym Microsoft Corporation.

Zrzeczenie się odpowiedzialności
• Zawartość tej instrukcji służy jedynie do celów informacyjnych. Z uwagi na, prowadzone przez

producenta, ciągłe doskonalenie i rozwój produktów, opisany Polar może, bez wcześniejszego
powiadomienia, ulegać modyfikacjom.

• Polar Electro Inc./Polar Electro Oy nie ponosi odpowiedzialności za treść instrukcji ani nie udziela
gwarancji na inne, opisane w instrukcji, produkty.

• Polar Electro Inc./Polar Electro Oy nie ponosi odpowiedzialności za zniszczenia/ straty/ koszty i
wydatki-bezpośrednie, pośrednie lub przypadkowe, związane z użytkowaniem niniejszej instrukcji oraz
produktu.

Ten produkt jest chroniony jednym z, lub kilkoma z następujących patentów: US 5486818, GB 2258587,
HK 306/1996, WO96/20640, EP 0748185, US6104947, EP 0747003, US5690119, DE 69630834,7-08,
WO 97/33512, US 6277080, EP 0984719, US 6361502, EP 1405594, US 6418394, EP 1124483, US
6405077, US 6714812, US 6537227, FI 114202, US 6666562 B2, US 5719825, US 5848027, EP
1055158, FI 113614, FI23471, USD49278S, USD492784S, USD492999S, FI68734, US4625733,
DE3439238, GB2149514, HK81289, FI88972, US5486818, DE9219139.8, GB2258587, FR2681493,
HK306/1996, FI96380, WO95/05578, EP665947, US5611346, JP3568954, DE69414362, FI4150,
US6477397, DE20008882, FR2793672, ES1047774, FI112844, EP 724859 B1, US 5628324, DE
69600098T2, FI110915. Kolejne patenty w trakcie rejestracji.

Wyprokukowano przez:
Polar Electro Oy
Professorintie 5
FIN-90440 KEMPELE
Tel +358 8 5202 100
Fax +358 8 5202 300
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Resetowanie odbiornika . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Rozpoczęcie pomiaru tętna . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Rozpoczęcie zapisu ćwiczenia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Running Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26, 57

Sposób wyświetlania 12h/24h . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Stopień aktywności . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Strefa czasowa . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Szacowane tętno maksymalne . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Słaba bateria . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

Totals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Tryb nocny . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Tworzenie ćwiczeń . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9, 9

Ustawianie stopera . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Ustawianie timera . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Ustawienia ćwiczenia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9, 9
Ustawienia daty . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Ustawienie alarmu/budzika . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Ustawienie godziny . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Ustawienie zapisu tempa . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Ustaw odliczanie dni do wydarzenia . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Uwagi . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

VO2max . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38, 45

Wodoszczelność . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Wybierz język . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Wybór jednostek . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Wybór typu ćwiczenia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Wydatek kaloryczny . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Zakładanie baterii . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
Zapis okrążeń . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Zaprogramowane ćwiczenie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42, 43
Zatrzymanie zapisu ćwiczenia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Zerowanie pliku totals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Zmiana wyświetlanych danych . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
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